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Краткий справочник по вышивальному 
программному обеспечению BERNINA 
Embroidery Software 
 
Режим вышивания - Embroidery Canvas 

 
 
 
 
 

Режим позволяет оцифровывать и 
редактировать образцы вышивки. 
Показывает как образцы вышивки, так и 
графические заготовки. Дает 
возможность просматривать образцы 
реалистически в трехмерной графике 3D 
 
Программа BERNINA Embroidery Software 
интегрируется с программой CorelDRAW® 
Essentials 4 , образуя единое приложение.  
Приложение имеет общее рабочее пространство 

(‘Design Window’), но работать в этом 
пространстве можно в двух разных режимах:  
Art Canvas (для дизайнерской работы) и 
Embroidery Canvas (для вышивок). Третий 
режим, Hoop Layout, предназначен для работы 
с большими проектами, не помещающимися в 
пяльцах.   
 
В этом кратком справочнике подробно 
описываются все опции меню и панелей 
инструментов, имеющиеся в режиме Embroidery 
Canvas. Не все описанные здесь опции имеются 
во всех уровнях продукта. См. также Список 
функций программного продукта. 
 
Окно Embroidery Canvas Design 
Design  
 
На показанном внизу экране отображены в 
развернутом виде все панели инструментов 
приложения BERNINA DesignerPlus.в окне 
Embroidery Canvas Design. 

 

 
 
 

Title bar – 
Menu bar – 

General toolbar –  
Stitch and Color Bar – 

Edit Toolbar –  
 

Строка заголовка  
Строка меню 
Общая панель инструментов 
Панель Стежок и Цвет 
Панель инструментов правки 
 

Edit Toolbar – 
Digitize Toolbar -
Arrange Toolbar-

Craft Stitch Toolbar– 
View  Mode Toolbar- 

Status bar - 

Панель инструментов правки 
Панель оцифровки  
Панель размещения 
Панель рукодельных стежков 
Панель режима просмотра   
Строка состояния 

Режим  Art Canvas 
 

Загружайте, 
редактируйте, 
сохраняйте в качестве 
фона для оцифровки 

вышивок любую графику. Это включает весь 
набор, предоставляемый программами 
CorelDRAW® Essentials 4. Дополнительно, 
предоставляется возможность 
конвертировать векторные рисунки и тексты 
непосредственно в объекты вышивания. 

В режиме Art Canvas, панель инструментов 
View Mode содержит кнопку Show Embroidery 
для включения/выключения дисплея вышивок. 
 
Ниже на рисунке показан вид рабочего экрана в 
режиме Art Canvas,  доступ к которому 
осуществляется через панель инструментов 
View Mode. Этот режим работы позволяет 
создавать и изменять векторную графику, 
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используя инструментарий CorelDRAW® 
Essentials 4,  позволяющий использовать 

различные продвинутые техники для создания 
набросков и рисунков прямо с экрана. 

 

 
 
Дополнительно к инструментарию CorelDRAW® 
Essentials 4, режим Art Canvas предоставляет 
возможность конвертировать векторную 
графику и тексты непосредственно в объекты 
вышивки. Векторная графика и тексты, 
созданные или импортированные в режиме Art 
Canvas можно непосредственно конвертировать 
в объекты вышивки. Можно использовать режим 
Art Canvas, чтобы вставлять векторную графику 
других производителей, например заготовочные 
рисунки для образцов вышивки. Дополнительно 
можно использовать растровые образцы для 
использования в качестве оцифровывающего 
фона.  
 
ВНИМАНИЕ: Полное описание инструментария 
программы CorelDRAW® Essentials 4 приводится 
в электронном Руководстве пользователя, 
которое можно найти в разделе меню Windows 
Start > Programs. Можно использовать экранную 
систему помощи с помощью меню Help в режиме 
Graphics. 

 

Режим Hoop Layout 
 
 
 
 
 

Позволяет просматривать и 
редактировать проекты, не помещающиеся 
в пяльцах. Если ваша вышивка слишком 
велика, или содержит много образцов, 
расположенных на пространстве, 
разбитом для вышивки на многих пяльцах. 
 
Ниже на рисунке показан вид рабочего 
экрана в режиме View Mode,  доступ к 
которому осуществляется через панель 
инструментов View Mode. 
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Если ваша вышивка слишком велика, или 
содержит много образцов, можно разбить 
ее на несколько пяльцев. Это позволяет 
вам создавать и работать с образцами, 
размер которых превышает размер любых 

отдельных пялец. Режим Hoop Layout 
позволяет установить положение и 
последовательность использования каждых 
пялец. См. раздел Закрепление в пяльцах 
крупных проектов

 
 
Строка меню Embroidery Canvas   
 
Строка меню окна Embroidery Canvas 
располагает описываемыми ниже 
выпадающими меню. Не все команды 
имеются во всех уровнях продукта. 
Некоторые их них доступны также через 
кнопки панелей инструментов. 
 
Примечание: Стандартная клавиша Alt 
системы Windows® используется для 
клавиатурных команд. Используйте 
клавишу Alt совместно с подчеркнутой в 
меню буквой. Для отмены операции 
нажмите дважды клавишу Esc. 
 
Меню File (Файл) 
 
New  Открыть новый пустой проект   
Open  Открыть проект.  
Close  Закрыть текущее окно проекта  
 

 
 
 
 
 
 

 
 
 
 
Portfolio  Запустить приложение BERNINA 

Portfolio и открыть проект  
 

Cross Stitch  Запустить программу вышивки 
крестом  
 

Quilter  Запустить программу квилтинга 

Insert Design  Вставить существующий проект  

Save  Сохранить текущий проект  
Save As  Сохранить текущий проект под 

другим именем, в другом месте 
или формате  
 

Save Design 
As Image  

Сохранить изображение проекта 
в режиме Design View или Artistic 
View. Сохраненное изображение 
точно такое, как появляется на 
экране.  
 

Design 
Properties  

Показать информацию о 
проекте, такую как размеры или 
количество стежков, и добавить 
комментарии о проекте для 
распечатки.  
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Print  Распечатать проект.  

 
Print Preview  Показать рабочий документ 

проекта. Распечатка рабочего 
документа из этого окна.  
 

Card / 
Machine Read  

Считать (открыть) проект из 
карты BERNINA Design Card или 
вышивальной машины 
BERNINA.  
 

Card / 
Machine Write  

Записать (сохранить) проект на 
карте BERNINA Design Card или 
в вышивальной машине 
BERNINA.  
 

Write to Magic 
Box  

Записать (сохранить) проект на 
карте памяти в приборе Magic 
Box.  

Read from 
Magic Box  

Считать (открыть) проект с 
карты памяти в приборе Magic 
Box.  
 

Recent File 
List  

Показать список недавно 
использованных файлов. 
Выбрать файл для открытия.  
 

Exit  Закрыть все открытые проекты и 
выйти из программы BERNINA.  

 
Меню Edit (Редактирование) 
 

Undo  
Отменить последнюю команду.  
 

Redo  Повторить выполнение 
отмененной команды.  
 

Cut  Удалить выделение с 
помещением в буфер обмена.  
 

Copy  Скопировать выделение в 
буфер обмена.  
 

Paste  Вставить содержимое буфера 
обмена в окно проекта.  
 

Duplicate  Дублировать выделение с 
помещением в текущее 
выделение.  
 

Delete  Удалить выделение без 
помещения в буфер обмена.  
 

Select All  Выделить все объекты в 
проекте.  
 

Deselect All  Отменить выделение всех 
объектов в проекте.  
 

Stitch Edit  Переместить вставленную точку 
в выбранную точку проекта.  

 

 
Smooth Curves Используйте функцию  

Smooth Curves, чтобы удалить 
лишние узлы изменения формы 
объектов вышивки. 
 

Lettering   
 

Изменить настройки текста.  

Elastic 
Lettering  

Применить специальные 
эффекты  к текстовым 
объектам, чтобы сделать текст 
выпуклым или дугообразным, 
растянутым или сжатым.  
 

Monogramming Создать персонализированные 
монограммы с выбором 
стандартных стилей монограмм, 
форм обрамления и 
орнаментов.  
 

Touch Up 
Picture  

Открыть стороннюю программу 
рисования для правки рисунка. 
  

Crop Image  Кадрировать изображение для 
использования в приложении 
PhotoSnap.  

 
 
Меню View (Вид) 
 
By Color  Показать только выбранные 

цвета в проекте.  
 

Needle Points Показать или скрыть точки 
прокола иглы. 
 

Picture  Показать или скрыть рисунок 
фона.  
 

Overview 
Window  

Показать или скрыть 
пиктограмму проекта.  
 

Show 1:1  Показать проект в натуральную 
величину.  
 

Show All  Показать проект целиком.  
 

Center Current 
Stitch 

Выровнять по центру текущий 
стежок. Есть и команда С + F6. 
 

Previous View Вернуться к предыдущему 
экрану просмотра. Есть и 
команда V + F5. 
 

Zoom Out 2X  Уменьшить 50 % текущее 
изображение проекта. Есть и 
команда Shift + Z + F10. 
 

Zoom In 2X Увеличить текущее 
изображение проекта до 200%. 
Есть и команда Z. 
 

Zoom   Увеличить и уменьшить 
изображение в окне проекта и 
увеличить в оконтуренных 
областях до полного размера 
окна. Есть и команда F8. 
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Zoom Factor Коэффициент масштаба 
Есть и команда F + F3. 
 

Redraw  
 

Перерисовать проект.  

Slow Redraw  Медленно перерисовать проект, 
чтобы увидеть 
последовательность 
вышивания.  
 

Hoop  Показать или скрыть пяльцы и 
изменить размеры и положение 
пялец.  
 

Grid  Показать или скрыть сетку и 
настроить размеры ячеек.  
 

Measure  Измерение размеров проекта.  
 
 
Меню Arrange (Расположение) 
 
Start and End  Установить начальную и 

конечную точки проекта.  
 

Stitch 
Sequence  

Автоматический выбрать 
последовательность вышивания 
для сведения к минимуму числа 
обрезок нитки и изменений 
цветов.   
 

Sequence as 
Selected  

Установить последовательность 
вышивания выделенных 
объектов в порядке выбора.  
 

Sequence to 
Start  

Переместить выбранный объект 
в начало последовательности 
вышивания.  

Sequence to 
End  

Переместить выбранный объект 
в конец последовательности 
вышивания.  
 

Sequence by 
Color  

Установить последовательность 
вышивания объектов в порядке 
выбранных цветов.  
 

Color Film  Открыть диалоговое окно Color 
Film.  
 

Mirror 
Horizontal  

Перевернуть выбранные 
объекты по горизонтальной оси. 
  

Mirror Vertical  Перевернуть выбранные 
объекты по вертикальной оси.  
 

Group  Сгруппировать выбранные 
объекты в единый объект.  
 

Ungroup  Разделить сгруппированные 
объекты в отдельные 
компоненты.  
 

Break Apart  Разделить монограммы, 
аппликации, тексты и элементы 
"черной вышивки" на отдельные 
объекты.  

 

 
Lock / Unlock 
All 

Блокировка и разблокировка 
объектов, с целью защитить их 
во время оцифровки или при 
редактировании. Клавиши 
быстрого выбора команды: K и 
Shift+K.  
 

Remove 
Overlaps  

Удалить нижний слой вышивки в 
перекрывающихся объектах.  
 

Add Holes  Удалить вышивальные стежки из 
формы (оставление отверстия).  
 

Fill Holes  Заполнение отверстий в 
объектах.  
 

Add Buttonhole Добавить пуговичную петлю к 
проекту.  
 

Pattern Stamp  Добавление единичных узоров в 
проект. 
 

Close Object Используйте эту команду, если 
вы хотите замкнуть объект, 
указав в опциях, какую 
замыкающую линию 
использовать: прямую или 
кривую. 
 

 
Меню Settings (Настройки) 
 
Thread 
Colors  

Назначить цвета ниток для 
использования в проекте.  
 

Fabric 
Settings  

Назначить типы тканей и настройки. 

Fabric 
Display  

Выбрать ткани и цвета фона.  

Object 
Properties  

Настроить свойства для выбранных 
форм.  
 

Options  Выбрать настройки для 
отображения окна.  
 

Security  Ввести коды для обновления или 
добавления опциональных функций.
  

Display 
Setup  

Калибровать экран.  

Scanner 
Setup  

Настройка опций сканера.  

Create 
Pattern  

Создание узоров с присвоением 
имени   
 

Create 
Border  

Создание обрамлений с 
присвоением имени   
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Меню Help (Справка) 
 
Help Topics  Вывести список тем 

онлайновой справки  
 

Onscreen Manual  Открыть отображаемое на 
экране руководство в 
формате Adobe Acrobat 
(PDF).  
 

Quick Start Guide Краткое справочное 
руководство 
 

Release Notes Информация о версии 
About  Показать информацию о 

версии ПО BERNINA.  
 

Show Design 
Warning  

Отобразить предупреждение 
при открытии проекта, 
размеры которого не могут 
быть изменены.  
 

BERNINA® 
International Home 
Page  

Открыть веб-сайт BERNINA® 
International.  

BERNINA® of 
America Home 
Page  

Открыть веб-сайт BERNINA® 
of America.  

Embroidery Online  Открыть веб-сайт Embroidery 
Online.  
 

Access Code 
Order Form  

Открыть код доступа (Access 
Code) к онлайновому 
формуляру заказа.  
 

Purchase Upgrade 
on the Internet  

Купить программу 
обновления непосредственно 
через Интернет.  
 

Install Upgrade  Загрузить коды доступа для 
вашего донгла после 
уведомления по электронной 
почте об успешной 
онлайновой покупке 
программы обновления.  

 

Режимы просмотра 
 
В программном пакете BERNINA 
предусмотрено три режима просмотра. В 
разных режимах отображаются разные 
панели инструментов. 
 

 

Загружайте, редактируйте, 
сохраняйте в качестве фона 
для оцифровки вышивок любую 
графику. Это включает весь 
набор, предоставляемый 
программами CorelDRAW® 
Essentials 4. Дополнительно, 
предоставляется возможность 
конвертировать векторные 
рисунки и тексты 
непосредственно в объекты 
вышивания. 
 

 

Режим позволяет 
оцифровывать и редактировать 
образцы вышивки. Показывает 
как образцы вышивки, так и 
графические заготовки. Дает 
возможность просматривать 
образцы реалистически в 
трехмерной графике 3D. 
 

 

Позволяет просматривать и 
редактировать проекты, не 
помещающиеся в пяльцах. 
Если ваша вышивка слишком 
велика, или содержит много 
образцов, расположенных на 
пространстве, разбитом для 
вышивки на многих пяльцах. 
 

 В режиме Art Canvas, панель 
инструментов View Mode 
содержит кнопку Show 
Embroidery для 
включения/выключения 
дисплея вышивок. 
 

 
Панели инструментов BERNINA  
 
В окне проектов имеются описываемые 
ниже панели инструментов. Не все панели 
инструментов имеются во всех уровнях 
продукта. Некоторые из них снабжены 
кнопками для открытия выпадающих меню. 
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Общая панель инструментов (General) 
Эти инструменты доступны в режиме просмотра 
Embroidery Canvas. 

New  То же, что File > New.  
 
 
Open  

 
 
То же, что File > Open.  

 
 
Save  

 
 
То же, что File > Save.  

 
 
Print  

 
 
Печать проекта с 
текущими настройками 
печати.  

 
Print 
Preview  

То же, что File > Print 
Preview.  

 
Write to 
Machine  

То же, что File > Card / 
Machine Write.  

 
Read from 
Magic Box  

Считывание проектов с 
карты памяти с 
использованием Magic 
Box.  

Write to 
Magic Box  

Сохранение проектов на 
карте памяти с 
использованием Magic 
Box.  

Cut  То же, что File > Cut.  

 
Copy 
 
 

То же, что Edit > Copy.  

Paste То же, что Edit > Paste.  

 
Undo То же, что Edit > Undo.  

 
 
 
Redo 

 
 
Same as Edit > Redo.  

 
 
Show Grid 

 
 
То же, что View > Grid.  

 
 
Show Hoop 

 
 
То же, что View > Hoop. 

 
Show 
Picture 

 
 
То же, что View > 
Picture.  

Dim Artwork 

Понизить или повысить 
яркость изображения, 
чтобы более четко 
видеть стежки 

Show 
Vectors 

Включение/отключение 
функции просмотра 
векторной графики. 
 

Show 
Stitches  

Включение/отключение 
показа стежков.  

 
  

 
Show Artistic 
View 
 

Включение/выкключение 
просмотра вида вышивки. 

Show Appliqué 
Fabric показа ткани/цвета аппликации. 

 
Object 
Properties 

То же, что Settings > Object 
Properties.  

Auto Underlay Автоматическое добавление 
стабилизирующих стежков.  

Textured Edge Добавление к объекту 
текстурированных краев.  

 
Color Film То же, что Arrange > Color Film.  

Carving Stamp

Задатьпоследовательности 
протыканий иглы, используя в 
качестве шаблона “резной штамп”. 
 

Morphing 
Effect 

Cоздание наброска 
преобразуемого объекта и его 
стежков  

 
Zoom Box То же, что View > Zoom Box.  

Show 1:1 То же, что View > Show 1:1.  

 
Show All То же, что View > Show All.  

 
Панель изображения (Image) 
Эти инструменты доступны в режиме 
просмотра Art Canvas. 
 

Load Picture  
Вставка изображения в окно 
проекта в ПО BERNINA Embroidery 
Software.  

 
 
 
Scan Picture  

 
 
Сканирование изображения в 
BERNINA.  

Touch Picture  

 
Отделка рисунка в программе 
Corel PHOTO-PAINT Essentials 4 
 

Save Picture  Сохранение изображения после 
правки.  
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Панель Art 
Эти инструменты доступны в режиме 
просмотра Art Canvas. 
 

Convert Vectors 
to Embroidery 

 
Преобразование векторной 
графики в объекты вышивания. 
 

 

Convert Text to 
Embroidery 

Преобразование векторного 
графического 
текста в образцы вышивки) 
 

 
ВНИМАНИЕ: Полное описание инструментария 
программы CorelDRAW® Essentials 4 приводится 
в электронном Руководстве пользователя, 
которое можно найти в разделе меню Windows 
Start > Programs. Можно использовать экранную 
систему помощи с помощью меню Help в режиме 
Graphics. 
 
Панель инструментов правки (Edit) 
 
Эти инструменты доступны в режиме 
просмотра Embroidery Canvas. 
 

Select 
Object  

Выбор объектов вышивки для 
изменения размеров, 
перемещения, перевод в 
зеркальное отображение или 
вращения.  
 

Polygon 
Select  

Выделение зон неправильной 
формы.   

 
Reshape 
Object  

 
Изменение выделенных 
вышивальных и текстовых 
объектов.  

 
Mirror 
Horizontal 

То же, что Arrange > Mirror 
Horizontal.  

 
 
Mirror 
Vertical  

То же, что  Arrange > Mirror 
Vertical  

Rotate 
45°CCW 
/CW  

Поворот выделенных 
объектов шагами по 45°. Для 
поворота против часовой 
стрелки щелчок левой 
кнопкой мыши. Щелчок 
правой кнопкой – поворот по 
часовой стрелке.  

 

Scale by 
20% 
Down /Up  

Изменение размера 
выделенного объекта шагами 
по 20%. Щелчок левой 
кнопкой – уменьшение, 
правой кнопкой – увеличение 
объекта. 

 

 
Double 
Run  

Повторное выполнение стежков в 
выбранных объектах.  

 
 
Remove 
overlaps 

То же, что Arrange > Remove 
overlaps 

 
 
Add Holes 

 
 
То же, что Arrange > Add Holes 

 
 
 
Fill Holes 

 
 
То же, что Arrange > Fill Holes 

 
 
Break 
Apart 

 
То же, что Arrange > Break Apart 

 
 
Color 
Blending  

 
Оцифровка объектов со 
смешанным цветом.  

Image 
Preparation

 
Подготовка изображения к 
автоматическому 
оцифровыванию 
 

Convert 
Selected 
Embroidery 
to Art 
Vectors 

Преобразование образца 
вышивки в векторный рисунок 
 
 

  

 
Панель оцифровки (Digitize)  
Эти инструменты доступны в режиме 
просмотра Embroidery Canvas. 
 

Auto 
Digitizer  

Автоматическая оцифровка 
подготовленных изображений.  

 
Magic 
Wand  
 

Оцифровка простых форм в 
проекте.  

PhotoSnap Преобразование ч/б или цветной 
фотографии в вышивку.  

 
Open 
Object  
 

Рисование и оцифровка открытых 
форм.  

Closed 
Object  

Рисование и оцифровка закрытых 
форм.  

 
Free Hand 
Embroidery 
Open 
Object 

Рисование контуров вышивки 
прямо на экране, с просмотром  
вида стежков по мере рисования. 
 

 
Free Hand 
Embroidery 
Closed 
Object 

Рисование “от руки” заполненных 
замкнутых объектов на экране. 
 

 
Block 
Digitizing  

Оцифровка колонок с 
переменными стежками.  
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Circle / Oval  

Рисование и оцифровка 
овалов или 
окружностей.  

 
 
Rectangle  

Рисование и оцифровка 
прямоугольников или 
квадратов.  

Lettering / Fill 
Values 

Создание и изменение 
свойств букв. 
 

Monogramming 

Создание 
персонализированных 
монограмм с выбором 
стандартных стилей 
монограмм, форм 
обрамления и 
орнаментов.   

 
Auto Applique  

Оцифровка замкнутого 
объекта аппликации.  

 
 
Partial 
Applique  

Создание объектов 
аппликации с частичным 
покрытием вышивкой.   

Advanced 
appliqué 

Generate open-object 
applique 
from one or more source 
objects. 
 

Outline Design 

Вышивка контуров 
объектов одинарными, 
тройными или 
гладьевыми линиями, 
 

 
Cross Stitch 

То же, что File > Cross 
Stitch.  

 

Quilter То же, что File > Quilter.  

 
Панель рукодельных стежков (Craft 
Stitch) 
Эти инструменты доступны в режиме просмотра 
Embroidery Canvas. 
 

Blackwork 
Run  

Автоматический выбор 
последовательности 
вышивания выбранных 
объектов.  

Blackwork 
Border  

Оцифровка обрамления 
стежками черной 
вышивки.  

Blackwork Fill  
Оцифровка заполнения 
стежками черной 
вышивки.  

Candlewicking 
Border  

Оцифровка линии 
узелковым швом.  

 
Candlewicking 
Fill  

Оцифровка заполнения 
узелковыми строчками.  

 
Lacework  

Оцифровка заполнения 
стежками кружевного 
переплетения .  

 

Stipple Run Оцифровка заполнения 
пунктирными стежками.  

Backstitch  
Оцифровка линии 
стежками  "назад в 
иголку".  

 
Stemstitch  

Оцифровка линии 
стебельчатыми 
строчками.  

Ripple 

Спиральное 
прострачивание от 
центра любого 
заполненного объекта. 
 

 
Панель стежков и палитры цветов (Stitch 
and Color) 
 

Выбор 
оконтуривающих 
стежков для новых и 
выделенных 
объектов.  
 
Показ типов 
оконтуривающих 
стежков для 
выделения.  
 
Выбор заполняющих 
стежков для новых и 
выделенных 
объектов.  
 
Показ типов 
заполняющих стежков 
для выделения.  
 
Установка углов 
наклона стежков для 
выбранных объектов. 
 
Удаление углов 
наклона стежков для 
замкнутых объектов с  
поворачиваю-щимися 
стежками. 
 
Формирование 
поворачивающихся 
заполняющих стежков 
нескольких типов, 
например, гладьевых 
и типа татами. 
 
Контурные 
заполняющие стежки 
вдоль оцифрованной 
направляющей линии,
поддерживающие 
постоянную плотность 
и варианты игольных 
проколов  
 

 
 

 
 
 
 

 
 

 
 
 
 
 
 

 Список доступных 
цветных ниток.  
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Панель размещения (Arrange) 
Эти инструменты доступны в режиме 
просмотра Embroidery Canvas. 
 

Group  То же, что Arrange > Group.  

Ungroup  То же, что Arrange > Ungroup. 

 
Lock 
 
 

 

Unlock  

 
Align Left 
(Vertical)  

Выравнивание выбранных 
объектов по левому краю.  

 

Align 
Centers 
(Vertical)  

Выравнивание центров 
выбранных объектов по 
вертикали.  

 
Align Right 
(Vertical)  

Выравнивание выбранных 
объектов по правому краю.  

 
Align Top 
(Horizontal)  

Выравнивание  выбранных 
объектов по верхнему краю.  

 

Align 
Centers 
(Horizontal)  

Выравнивание центров 
выбранных объектов по 
горизонтали.  

 

Align 
Bottom 
(Horizontal)  

Выравнивание  выбранных 
объектов по нижнему краю.  

 

Align 
Centers  

Выравнивание центров 
выбранных объектов по 
центру проекта.  

 

Mirror- 
Merge 
Horizontal  

Зеркальное переворачивание 
по горизонтали с 
дублированием объектов  

 

Mirror- 
Merge 
Vertical  

Зеркальное переворачивание 
по вертикали с 
дублированием объектов  

 

Mirror- 
Merge 
Horizontal 
& Vertical  

Зеркальное переворачивание 
по горизонтали и вертикали с 
дублированием объектов  

Wreath  Дублирование объектов 
вокруг центральной точки.  

 

Kaleidos-
cope  

Зеркальное переворачивание 
объектов вокруг центральной 
оси.  

 

 
Панель Color Film 
 

Show 
Individual 
Objects  
 
 

Просмотр индивидуальных объектов в 
порядке последовательности 
вышивания. Перетаскивание значков 
объектов для изменения 
последовательности.   

Sequence 
As 
Selected 
 

Изменение последовательности 
выделенных объектов  

Sequence 
By Color  
 

Изменение последовательности 
объектов по цвету  

Sequence 
to Start  

Перемещение выбранного объекта в 
начало последовательности 
вышивания.  

Sequence 
to End  

Перемещение выбранного объекта в 
конец последовательности 
вышивания.  
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Панель Multi-Hooping 
Эти инструменты доступны в режиме 
просмотра Hoop Layout. 
 

Selection 
on 

Выбор пялецев в окне 
проекта. 

 
Reshape 
Splitting 
Guide 

 
Перерисовка разделительных 
линий в окне проекта Design 
Window. 

 
 
Add 
Hoop 

 

 

Центровка новых пялец в окне 
проекта в вертикальной 
ориентации.  

Add 
Hoop 
Right 

Помещение новых пялец 
непосредственно справа от 
выбранных пялец с 10-мм 
перекрытием полей 
вышивания.  

Add 
Hoop Up 

Помещение новых пялец 
непосредственно над 
выбранными пяльцами.  

Add Four 
Adjacent 
Hoops 

Автоматическое добавление 
четырех новых положения 
пялец по периметру 
выбранной позиции пялец. 

 
 
Add Eight 
Adjacent 
Hoops 

 
Автоматическое добавление 
восьми новых положения 
пялец по периметру 
выбранной позиции пялец. 

Splitting 
Guide 

Оцифровка разделительных 
линий большого образца 
перед тем, как передать 
информацию в файл, на 
машину или на карту памяти.  

 
 
 
Delete 
Hoop 

 

Удаление пялец из окна 
проекта.  

Rotate 
Hoop 

Щелкните по кнопке  левой 
или правой кнопкой мыши, 
чтобы повернуть выбранные 
пяльцы на 45° по или против 
часовой стрелки.   

 

Calculate 
Hoopings 

Определение количества 
перезаправок пялец на основе 
текущей компоновки пялец. 
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Краткий справочник по программе  
BERNINA Portfolio 
 
Этот краткий справочник содержит все пункты меню и элементы панелей инструментов, 
имеющиеся в программе BERNINA Portfolio. 
 
Окно программы BERNINA Portfolio  
 

 
Change Design View Изменить вид проекта 
Folders Папки 
Design thumbnails contained in selected 
folder 

Пиктограммы проектов выбранной 
папки 

Status bar Строка текущего состояния 
Menu bar Панель меню 
Toolbar Панель инструментов 
Split bar Разделитель экрана 

 
Меню программы Portfolio  
 
Панель меню окна программы Portfolio 
содержит несколько закладок с 
выпадающими списками функций, 
описанными далее. Некоторые функции 
дублируются кнопками панели 
инструментов. Подчеркнутые буквы в 
наименованиях пунктов меню позволяют 
обращаться к соответствующим функциям 
без использования мыши. Надо нажать 
клавишу Alt и соответствующую 
подчеркнутую букву на клавиатуре. Чтобы 
отменить операцию надо два раза нажать 
клавишу Esc.  
 

Раздел меню File (“Файл”) 
 
New Открывает новый шаблон в 

вышивальной программе 
BERNINA Embroidery Software. 
 

Open with 
BERNINA 
Embroidery 
Software 

Открывает проект в программе 
BERNINA Embroidery Software. 
 

Open Открывает проект в программе 
BERNINA Embroidery Software 
или рисунок в графических 
программах. 
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Print Catalog Распечатывает пиктограммы 
проектов, с комментариями или 
без. 

HTML 
Catalog 
 

Сохраняет каталог проектов в виде 
HTML =файла, пригодного для 
публикации в сети Web. 
 

Export 
Design List 
 

Выводит информацию о проектах в 
текстовый файл, пригодный для 
импорта в базу данных или для 
распространения информации. 
 

Create Zip 
Archive 
 

Выводит информацию о проектах в 
архивный файл, пригодный для 
отправки по электронной почте или 
сохранения на диске. 
 

Extract Zip 
Archive 
 

Открывает архивный файл, 
сохраненный на диске или 
пришедший по почте. 
 

Print 
Worksheet 
 

Печать отобранных проектов 
 

Write to 
Card/ 
Machine 
 

Запись отобранных проектов на 
карту проектов Bernina. 
 

Convert Преобразует проекты в выбранный 
формат. 
 

Properties Открывает диалоговое окно 
“Свойства” ( Properties) для 
указанного проекта. 
 

Exit Закрывает все открытые проекты. 
Выход из программы Portfolio. 
 

 
Раздел меню Edit (“Редактирование”) 
 
Cut Удаляет выделение, помещая  в 

буфер. 
 

Copy Скопировать выделение в буфер 
обмена.  
 

Paste Вставить содержимое буфера 
обмена в окно проекта.  
 

Delete Удалить выделение без 
помещения в буфер обмена.  
 

Select All Выделить все объекты в проекте.  
 

Deselect All Отменить выделение всех 
объектов в проекте.  
 

 

Раздел меню View (“Вид”) 
 
Design 
Thumbnails 
 

Отображает пиктограммы проектов 
в папке. 
 

Design 
Thumbnails 
and 
Summary 
 

Отображает пиктограммы проектов 
в папке с комментариями. 
 

Design List Отображает параметры файла, 
такие, название проекта, размер 
файла, его тип и дата. 

Sort Выбор способа сортировки 
проектов 
 

Sort by 
Design 
Name 
 

Сортировка по названию. * 
 

Sort by File Сортировка по типу файлов. * 
 

Sort by File 
Size 

Сортировка по размеру файлов. * 
 

Sort by Last 
Changed 
 

Сортировка проектов по дате 
создания. * 
 

Refresh Обновить экран с файлами 
проектов. 
 

Refresh 
Folder 

Обновить отображение папки. 
 

Validate and 
Refresh 
 

Подтвердить и обновить 
содержимое папок. 
 

Browse 
Location 

Выбор папок из дерева. 
 

Folders Включить/отключить отображение 
дерева папок 
 

Change 
Locale 

Перейти на другой язык дисплея. 
 

User 
Preferences 
 

Изменение настроек по 
умолчанию. 
 

Customize 
Columns 
 

 
Переделать список проектов. 
 

* Двукратное нажатие меняет порядок сортировки 
(восходящий или нисходящий). 
 
Главная панель инструментов 
программы Portfolio  
В окне программы BERNINA Portfolio  
имеется только одна панель инструментов, 
описанная далее. Некоторые кнопки панели 
дублируют функции списков меню. 
 



BERNINA Portfolio – Краткий справочник 

BERNINA® Вышивальное ПО  Версия 6 412

Главная панель инструментов 
 

 
То же, что File > Open 
 
То же, что File > Print 
 
То же, что File > Write to 
Card/Machine 
 
 
То же, что File > Convert
 
 
То же, что View > Folder 
 
 
То же, что View > Sort 
 

Меняет вид 
отображения проектов 
(пиктограммы, 
пиктограммы с 
комментариями, список 
проектов) 
То же, что File > Create 
Zip Archive 
То же, что File > 
Properties 
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Клавиатурные команды 
 
Команды выбираются таким же образом, 
как и в других приложениях Windows®, – из 
меню или панелей инструментов. Для 
наиболее часто используемых команд 
имеются также клавишные комбинации 
быстрого вызова – клавиатурные команды. 
 
Общие функции   
Чтобы … следует нажать 

создать новый проект 
 
 

открыть существующий 
проект  
 
сохранить проект 
 
распечатать проект. 
 

отменить выполненную 
команду 
повторить выполнение 
отмененной команды 
отменить команду 
 

выйти из программы 
 

 
Выбор объектов 
Чтобы … следует нажать 

выделить все объекты 
 
отменить выделение всех 
объектов 
активировать инструмент Select 
Object 
выбрать объект, находящийся 
ниже 
выбрать несколько объектов 
 
выбрать нескольких 
последовательно 
расположенных объектов 
выбрать следующий объект 
выбрать предыдущий объект 

добавить следующий по 
очереди объект к выделенным 
добавить предыдущий по 
очереди объект к выделенным 

 
 

Просмотр проектов 
 

Чтобы … следует 
нажать 

или 

увеличить в 2 раза 
 
уменьшить в 2 раза 
увеличить до размера выделенной 
зоны 
установить масштаб 1:1 (100 %) 
задать коэффициент 
масштабирования 
показать проект целиком 
Показать предыдущий вид 
просмотра  
 

 
Чтобы … следует 

нажать 
или 

задать коэффициент 
масштабирования 
выровнять по центру текущий стежок 
вернуться к предыдущему экрану 
просмотра 
перерисовать экран 
показать / скрыть изображение 
показать / скрыть векторы 
Включить / выключить просмотр 
вышивки 
показать точки прокола иглой 
 

 
показать только выделенные 
объекты 
измерить 
показать контуры (только для 
BERNINA Quilter) 

 
Просмотр последовательности 
вышивания 
 

следует нажать Чтобы перейти ... 
на основной 
клавиатуре 

 на цифровой 
 панели  

к началу проекта  

к концу проекта  

к следующему цвету  

к предыдущему цвету  

к следующему объекту  

к следующему выбранному 
объекту 

 

к предыдущему объекту  

к предыдущему выбранному 
объекту 

 

на 1 стежок вперед †  

на 1 стежок назад †  

на 10 стежков вперед †  

на 10 стежков назад †  

на 100 стежков вперед  

на 100 стежков назад  

на 1 сегмент вперед  

на 1 сегмент назад  

активировать замедленное 

перерисовавание 

 
 

* Клавиша Num Lock отключена  
† Функция инструмента Select Object отключена 
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Оцифровка и создание текстов 
 
Чтобы …  следует нажать 
Запустить двойной прогон  
Удалить последнюю 
введенную точку 

* 

завершить оцифровку 
объекта 

* 

включить / выключить 
стабилизирующие стежки 

 

отобразить диалоговое окно 
текста 

 

* Только для BERNINA DesignerPlus 
 
 
Работа с объектами и стежками 
 
 

Вырезание и вставка объектов 
 
Чтобы … следует нажать 
вырезать объект  

скопировать объект  

вставить объект  

дублировать объект  

клонировать объект   
усилить контур 

удалить выделенный объект / 

объекты или последний 

объект 

 

 

 
Для того, чтобы …  нажать или щелкнуть мышью
перемещать выделенные объекты 
отдельными шагами 

 

переместить объект по горизонтали и 
вертикали 
 

 

сохранить пропорции объекта во 
время изменения размеров 
 

† 

изменить тип контрольной точки 
изменения формы 

 

 
 
 
 

 

объединить в группу выделенные 
объекты 

 

разгруппировать выделенные 
объекты 

 

перегруппировать разгруппированные 
объекты 

* 

Заблокировать выделенный объект  
Разблокировать выделенный объект 
 

 

перевести объект на передн. план * 
перевести объект на один слой 
вперед 

* 

перевести объект на задний план 
 

* 

перевести объект на 1 слой вперед * 
активировать редактирование стежка  

 
†Используйте Alt+Drag с BERNINA Quilter  
* Только для BERNINA Quilter  
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Список функций вышивального программного обеспечения BERNINA  
 
Возможность Название 

функции EditorPlus DesignerPlus Соответствующие темы в экранном 
руководстве 

Основы     "Основные процедуры" 
Открытие проектов из ПК     "Открытие проектов" 
Открытие составных 
проектов     "Открытие проектов" 

Создание проектов 
(шаблонов)      "Запуск новых проектов" 

Сохранение проектов     "Сохранение проектов" 
Отображение пялец и 
сетки     "Пяльцы и сетки" 

Измерение расстояний на 
экране     "Измерение расстояний на экране" 

Отмена команды и 
восстановление действия 
отмененной команды 

Undo/Redo    "Отмена и повторение отмененных 
команд" 

Перемещение/Размещение 
панелей инструментов     "Перемещение и установка панелей 

инструментов" 
Доступ к свойствам 
объекта 
 

   "Доступ к свойствам объекта“ 
 

Просмотр проектов     "Просмотр проектов" 
Просмотр проектов в 
режиме Art Canvas  Art Canvas ∆ ∆ "Режим дизайна Art Canvas“ 

Просмотр проектов в 
режиме Embroidery Canvas 

Embroidery 
Canvas 

∆ ∆ "Режим вышивания Embroidery Canvas“ 

Просмотр проектов в 
режиме Hoop Layout 

Hoop 
Layout 

 ∆ "Режим Hoop Layout" 

Просмотр вида вышивки Artistic 
View   Просмотр вида вышивки 

Просмотр стежков 
вышивки Stitch View   Просмотр вида вышивки 

Просмотр точек прокола 
иглой     "Просмотр точек прокола иглой" 

Просмотр стежков и 
контуров    "Просмотр стежков и контуров" 

Просмотр объектов 
проекта в цвете     "Просмотр объектов в цвете" 

Просмотр проектов в 
обзорном окне 

Overview 
Window    "Просмотр проектов в обзорном окне" 

Увеличение и уменьшение 
изображения     "Увеличение и уменьшение 

изображения" 
Просмотр 
последовательности 
вышивания отдельных 
фрагментов 

   

Просмотр последовательности 
вышивания отдельных 
фрагментов 
 

Обход по стежкам    Обход по стежкам 
Моделирование образцов 
вышивки 

Slow 
Redraw   Моделирование образцов 

вышивки 
Отображение или скрытие 
оригинала    Отображение или скрытие оригинала 

Изменение цветов фона 
или ткани     "Изменение фона" 

Просмотр информации о 
проекте     "Просмотр свойств проекта" 

Предварительный 
просмотр проектов     "Предварительный просмотр проектов" 

Выбор объектов    "Выбор объектов" 
Выбор объектов методом 
"указать и щелкнуть" 

Select 
Object    "Выбор объектов методом указать и 

щелкнуть" 
 

 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 

функции EditorPlus DesignerPlus Соответствующие темы в 
экранном руководстве 

Выбор объектов 
ограничивающим 
прямоугольником 

    
"Выбор объектов 
ограничивающим 
прямоугольником" 

Выбор объектов 
ограничивающим 
многоугольником 

Polygon 
Select     "Выбор объектов инструментом 

Polygon Select" 

Выбор объектов клавишей Tab      "Выбор объектов клавишей Tab" 
Выбор всех объектов в проекте     "Выбор всех объектов в проекте"
Отмена выделения объектов     "Отмена выделения объектов" 
Выбор цветных блоков и 
манипуляция с ними 

Color Film   "Просмотр и выделение цветных 
блоков" 

Работа с пяльцами    "Закрепление проектов в 
пяльцах" 

Отображение пялец     "Выбор пялец" 
Создание проектов не 
помещающихся в пяльцах 

Hoop 
Layout 

 ∆ "Закрепление в пяльцах крупных 
проектов"  

Разбиение объектов по разным 
позициям пялец 

Splitting 
Guide 

 ∆ Разбиение объектов по разным 
позициям пялец 

Создание собственных пялец     "Определение пользовательских 
пялец" 

Настройка собственных пялец    "Настройка собственных пялец" 

Система setup     "Настройка аппаратных и 
программных средств" 

Калибровка монитора     "Калибровка монитора" 
Настройка опций сетки     "Настройка опций сетки" 
Настройка опций 
автоматической прокрутки  ∆ ∆ Настройка опций 

автоматической прокрутки 
Настройка опций пялец     "Настройка опций пялец" 
Настройка опций замкнутого 
объекта аппликации 

Auto 
Appliqué 

  "Настройка опций 
автоаппликации"" 

Настройка опций удаления 
перекрытий 
 

Remove 
Overlaps 

  Настройка опций удаления 
перекрытий 
 

Установка функции 
автоматического сохранения    "Установка функции 

автоматического сохранения" 
Настройка опций отображения 
указателя мыши    "Настройка опций отображения 

положения указателя мыши" 
Установка других общих опций    "Настройка других общих опций"
Методы оцифровки    "Методы оцифровки" 
Переключение между методами 
оцифровки заполнения и 
контура 

 
  "Переключение между методами 

оцифровки заполнения и 
контура" 

Оцифровка открытых фигур Open 
Object  

  "Оцифровка открытых фигур" 

Оцифровка замкнутых фигур Closed 
Object  

  "Оцифровка замкнутых фигур" 

Оцифровка колонок с 
изменяющейся шириной 

Block 
Digitizing  

  "Оцифровка колонок с 
изменяющейся шириной" 

Оцифровка окружностей и 
овалов Circle/Oval   "Оцифровка окружностей и 

овалов" 
Оцифровка квадратов и 
прямоугольников Rectangle   "Оцифровка квадратов и 

прямоугольников" 
Оконтуривающие и 
заполняющие стежки    "Оконтуривающие и 

заполняющие стежки" 

Выбор оконтуривающих стежков    "Выбор оконтуривающих 
стежков" 

Выбор заполняющих стежков    "Выбор заполняющих стежков" 
 

 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции EditorPlus DesignerPlus Соответствующие темы в 

экранном руководстве 

Создание контуров 
одинарным/тройным стежком Single/Triple

  "Создание контуров одинарным и 
тройным оконтуривающим 
стежком" 

Создание контуров гладьевым 
валиком Satin    "Создание контуров стежком 

гладьевого валика" 
Создание контуров  
краеобметочным стежком Blanket    "Создание контуров 

краеобметочным стежком" 
Создание заполнения 
гладьевыми стежками Satin Fill    "Создание заполнения 

гладьевыми стежками" 
Создание заполнения 
простегивающими стежками Step Fill    "Создание заполнения 

простегивающими стежками" 
Изменение узоров 
простегивающих стежков Step Pattern   "Применение узоров 

простегивающих стежков" 
Цвета ниток и таблицы ниток   Цвета ниток и таблицы ниток 

Изменение цвета ниток     "Изменение цвета ниток" 
Изменение цвета выбранных 
объектов    Изменение цвета выбранных 

объектов 
Поиск и выбор ниток     "Поиск и выбор ниток" 
Подбор и выбор ниток    "Подбор и выбор ниток" 
Изменение цветов всего 
проекта  ∆ ∆ Изменение цветов всего проекта 

Изменение таблиц ниток    "Изменение таблиц ниток" 
Создание пользовательской 
таблицы ниток    "Создание пользовательской 

таблицы ниток" 
Свойства объекта и шаблоны   Свойства объекта и шаблоны 

Настройка текущих свойств 
объекта    "Настройка текущих свойств 

объекта" 

Изменение свойств объекта    "Изменение свойств выбранных 
объектов" 

Изменение стандартных 
свойств объекта    "Изменение стандартных свойств 

объекта" 
Создание шаблонов проекта    "Создание шаблонов проекта" 
Изменение шаблонов проекта    "Изменение шаблонов проекта" 
Сохранение текущих свойств в 
шаблоне    "Сохранение текущих свойств в 

шаблоне" 
Возвращение к шаблону 
NORMAL    "Возвращение к шаблону 

NORMAL" 

Повышение качества вышивания   Повышение качества 
вышивания  

Регулировка настроек ткани    "Регулировка настроек ткани" 
Применение автоматической 
стабилизации ткани    "Стабилизация ткани стежками"  

Применение автоматической 
компенсации стягивания ткани    "Компенсация стягивания ткани" 

Сохранение длинных стежков  Auto Jump   "Сохранение длинных стежков"  
Настройка закрепляющих 
стежков    "Настройка опции закрепляющих 

стежков" 
Настройка автоматических 
начальных и конечных точек 

Auto 
Start/End 

  "Настройка автоматических 
начальных и конечных точек" 

Оцифровка с оригиналом    "Оцифровка с оригиналом" 
Сканирование растровых 
изображений  ∆ ∆ "Сканирование растровых 

изображений" 
Загрузка растровых и 
векторных рисунков  ∆ ∆ "Загрузка изображений" 

Кадрирование изображений 
для оцифровки    "Кадрирование изображений для 

оцифровки" 
 

 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции EditorPlus DesignerPlus Соответствующие темы в 

экранном руководстве 
Изменение формы 
кадрированных изображений 

Reshape 
Object 

  "Изменение формы 
кадрированных изображений" 

Редактирование изображений 
в пакете графических 
программ  

Touch Up 
Picture 

∆ ∆ Редактирование изображений в 
пакете графических программ 
 

Сохранение оригиналов в 
отдельных файлах    "Сохранение оригиналов в 

отдельных файлах" 
Подготовка не оконтуренных 
изображений 

Image 
Preparation 

∆ ∆ "Подготовка не оконтуренных 
изображений" 

"Подготовка оконтуренных 
изображений" 

Outlined Image 
Preparation 

∆ ∆ "Подготовка оконтуренных 
изображений" 

Автоматическая оцифровка    "Автоматическая оцифровка" 
Преобразование векторных 
рисунков в вышивки 

Convert to 
Embroidery 

∆ ∆ Преобразование векторных 
рисунков в вышивки 
 

Преобразование образца 
вышивки в векторный рисунок 
 

Convert 
Selected 
Embroidery to 
Art Vectors  

 ∆ Преобразование образца 
вышивки в векторный рисунок 
 

Автоматическая оцифровка 
заполненных форм Magic Wand 

  "Автоматическое оцифровка 
заполнения" 

Автоматическая оцифровка 
контуров Magic Wand   "Автоматическая оцифровка 

контуров" 
Автоматическая оцифровка 
всего изображения Auto Digitizer   "Автоматическая оцифровка 

всего изображения" 
Автоматическое создание 
контуров и границ 

Auto Digitizer ∆ ∆ Автоматическое создание 
контуров и границ 

Создание проектов вышивки 
по фотографиям PhotoSnap   "Создание проектов функцией 

PhotoSnap" 

Комбинирование и последовательность 
объектов   

"Комбинирование и 
последовательность 
объектов" 

Вставка объектов 
    Вставка объектов 

Копирование и вставка 
объектов    "Копирование и вставка 

объектов" 
Дублирование объектов 
    "Дублирование объектов" 

Клонирование объектов 
 Quick Clone   "Клонирование объектов" 

Группировка/разгруппировка 
объектов Group/Ungroup   "Группировка и разгруппировка 

объектов" 

Отделение части объекта Break Apart   "Разбивка объектов на 
компоненты" 

Изменение 
последовательности объектов    "Установление 

последовательности объектов" 

Манипулирование цветными 
блоками и объектами Color Film 

∆ ∆ "Установление 
последовательности объектов 
функцией Color Film" 

Автоматическое установление 
последовательности всего 
проекта 

Stitch 
Sequence 

  "Автоматическое установление 
всего проекта" 

Расположение и 
трансформация объектов    "Расположение и 

трансформация объектов" 
Позиционирование объектов    "Позиционирование объектов" 
Выравнивание объектов    "Выравнивание объектов" 
Изменение размеров 

объектов  
  

"Изменение размеров объектов" 

Вращение объектов    "Вращение объектов" 
Перекос объектов    "Перекос объектов" 

 
 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции EditorPlus DesignerPlus Соответствующие темы в 

экранном руководстве 
Перевод объектов в 
зеркальное отображение    "Перевод объектов в зеркальное 

отображение" 
Зеркальное переворачивание 
с дублированием объектов    "Зеркальное переворачивание с 

дублированием объектов" 

Создание венков    "Создание венков" 

Изменение формы и правка 
объектов    "Изменение формы и правка 

объектов" 

Изменение формы объектов Reshape Object   "Изменение формы объектов" 

Подгонка углов наклона 
стежков  ∆ ∆ "Подгонка углов наклона 

стежков" 
Изменение точек входа и 
выхода    "Изменение точек входа и 

выхода" 

Редактирование стежка    "Редактирование стежков" 

Выбор стежков    "Выбор стежков" 

Вставка стежков    "Вставка стежков" 

Перемещение стежков    "Перемещение стежков" 

Удаление стежков    "Удаление стежков" 

Специальная техника 
оцифровки    "Специальная техника 

оцифровки" 

Создание “ручных”вышивок   ∆ Создание “ручных”вышивок 

Упрочнение контуров    "Упрочнение контуров"  

Вырезание отверстий в 
объектах Add Holes   "Вырезание отверстий в 

объектах" 
Удаление подстилающих 
стежков  

Remove 
Overlaps 

  "Удаление подстилающих 
стежков"  

Заполнение отверстий в 
объектах Fill Holes   "Заполнение отверстий в 

объектах" 
Создание контуров и границ Outline Design  ∆ Создание контуров и границ 

Создание пуговичных петель Add Buttonhole   "Создание пуговичных петель" 

Эффекты художественного 
вышивания    "Эффекты художественного 

вышивания" 
Создание контурного 
заполнения Contour  ∆ Создание контурного 

заполнения 
Создание заполнения 
орнаментными стежками  Fancy Fill   "Создание заполнения 

орнаментными стежками" 
Создание заполнений 
перекрестными стежками Cross Stitch   ∆ Создание заполнений 

перекрестными стежками 
Создание текстурированных 
краев Textured Edge   "Создание текстурированных 

краев" 
Создание эффекта 
волнистости Wave Effect   "Создание эффекта 

волнистости" 
Создание эффекта 
заполнения звездочками   ∆ Создание эффекта заполнения 

звездочками 
Создание заполнения с 
плавным тоновым переходом Gradient Fill   "Создание заполнения с 

плавным тоновым переходом" 
Создание открытых 
заполнений 

Travel on 
Edges 

  "Создание открытых 
заполнений" 

Создание эффекта 
смешивания цветов Color Blending   "Создание эффекта смешивания 

цветов" 
Создание эффектов плавного 
преобразования Morphing   Создание эффектов плавного 

преобразования 
 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции EditorPlus DesignerPlus Соответствующие темы в 

экранном руководстве 
Оконтуривание и 
заполнение узорами    Узорные штампы, контуры и 

заполнения 
Добавление узорных 
штампов Pattern Stamp   "Добавление узорных штампов" 

Создание цепочки узоров Pattern Run   "Создание узорных контуров" 

Создание узорных 
заполнений Pattern Fill   "Создание узорных заполнений" 

Создание собственных 
комплектов узоров    "Создание собственных 

комплектов узоров" 
Создание узоров фукнкция 
“резной штамп” Carving Stamp  ∆ Функция “резной штамп” 

Оконтуривание и 
заполнение рукодельными 
стежками 

   "Оконтуривание и заполнение 
рукодельными стежками" 

Создание контуров в технике 
"черной вышивки" 
("блэкуорк")  

Blackwork 
Border   "Создание контуров в технике 

"черной вышивки" ("блэкуорк")"  

Создание контуров стежками 
"назад в иголку" ("бэкстич")  Backstitch   "Создание контуров стежками 

"назад в иголку" ("бэкстич")" 
Создание контуров 
стебельчатыми стежками  Stemstitch   "Создание контуров 

стебельчатыми стежками"  
Создание контуров 
узелковым швом 

Candlewicking 
Border   "Создание контуров узелковым 

швом" 
Создание заполнений в 
технике "черной вышивки" 
("блэкуорк")  

Blackwork Fill  
 "Создание заполнений в технике 

"черной вышивки" ("блэкуорк")"  

Создание заполнений 
узелковыми строчками 

Candlewicking 
Fill   "Создание заполнений 

узелковыми строчками" 
Создание заполнения 
стежками кружевного 
переплетения 

Lacework  
 "Создание заполнения стежками 

кружевного переплетения" 

Создание спиральных 
заполнений Ripple  ∆ Создание спиральных 

заполнений 
Создание пунктирного 
заполнения  Stipple  ∆ "Создание пунктирного 

заполнения"  

Аппликации    "Оцифровка для аппликаций" 

Создание аппликаций Auto Applique   "Создание замкнутого объекта 
аппликации" 

Создание частичного 
покрытия объектов 
аппликации 

Partial Applique  
 "Создание частичного покрытия 

объектов аппликации" 

Создание открытого объекта 
аппликации 

Open-Curve 
Applique   "Создание открытого объекта 

аппликации" 

Вышивание текстов    "Вышивание текстов" 

Добавление текста к 
проектам вышивки     "Добавление текста к проектам 

вышивки"  
Создание горизонтальных 
базовых линий    "Создание горизонтальных 

базовых линий" 
Создание вертикальных 
базовых линий    "Создание вертикальных 

базовых линий" 
Создание базовых линий по 
окружности    "Создание базовых линий по 

окружности" 
Создание сложных базовых 
линий    "Создание сложных базовых 

линий" 
Создание пользовательских 
базовых линий    "Создание пользовательских 

базовых линий" 
Формат текста (курсив, 
полужирный, выравнивание)    "Форматирование текста" 

 
 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции 

EditorPlus DesignerPlus Соответствующие темы в 
экранном руководстве 

Настройка интервалов между 
буквами     "Настройка интервалов" 

Правка текста    Правка текста 

Изменение размеров текста    "Изменение размеров текста" 

Отмена стабилизации для 
небольших букв    "Отмена стабилизации для 

небольших букв" 
Преобразование текстовых 
объектов     "Преобразование текстовых 

объектов" 
Установка положения 
отдельных букв  ∆ ∆ Установка положения отдельных 

букв 
Добавление угла наклона 
стежков к буквам    "Добавление угла наклона 

стежков к буквам" 

Изменение цвета букв    "Изменение цвета букв" 

Текстовые эффекты    Текстовые эффекты 

Преобразование текста в 
вышивку  ∆ ∆ Преобразование текста в 

вышивку 
Конвертирование шрифтов 
TrueType в вышивальные 
шрифты 

 
  "Конвертирование шрифтов 

TrueType в вышивальные 
шрифты" 

Добавление специальных 
шрифтовых знаков и 
символов 

  
  "Добавление специальных 

символов" 

Специальные алфавиты    "Использование специальных 
алфавитов" 

Создание специальных 
эффектов функцией Elastic 
Lettering 

Elastic Lettering
  "Создание специальных 

эффектов функцией Elastic 
Lettering" 

Создание монограмм    "Создание монограмм" 

Создание текста монограммы 
с инициалами Monogramming ∆ ∆ "Создание текста монограммы с 

инициалами" 
Создание текста монограммы 
с именами  ∆ ∆ "Создание текста монограммы с 

именами" 
Добавление орнаментов к 
монограммам    "Добавление орнаментов к 

монограммам" 
Компоновка элементов 
орнамента    Компоновка элементов сложного 

орнамента 
Добавление бордюров к 
монограммам    "Добавление бордюров к 

монограммам" 
Создание собственных 
бордюров    "Создание пользовательских 

базовых линий" 

Обработка проекта    "Обработка и вывод проекта" 

Распечатка проектов    "Предварительный просмотр и 
распечатка проектов" 

Настройка опций распечатки 
проектов     "Настройка опций распечатки 

проектов"  
Распечатка выкроек 
аппликации    "Распечатка выкроек 

аппликации" 
Распечатка таблицы Color 
Film    "Распечатка таблицы Color Film" 

Распечатка проектов, не 
помещающихся в пяльцах  ∆ ∆ Распечатка проектов, не 

помещающихся в пяльцах 

Распечатка таблиц ниток    "Распечатка таблиц ниток" 

Сохранение проектов как 
изображений"    "Сохранение проектов как 

изображений" 

Вышивание проектов    "Вышивание проектов" 

 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции 

EditorPlus DesignerPlus Соответствующие темы в 
экранном руководстве 

Вывод проектов, не 
помещающихся в пяльцах   ∆ "Вывод проектов, не 

помещающихся в пяльцах" 
Открытие стежковых файлов 
с конвертированием объекта    "Открытие файлов с 

конвертированием" 
Открытие стежковых файлов 
без конвертирования объекта    "Открытие файлов без 

конвертирования" 
Открытие проектов из 
машины    "Считывание проектов из 

машины" 

Запись проектов в машину    "Запись проектов в машину" 

Запись проектов на USB stick    Запись проектов 
непосредственно  на USB stick 

Сохранение проектов 
функцией Magic Box    "Сохранение проектов функцией 

Magic Box" 
Сохранение проектов в 
формате PES     "Сохранение проектов в 

формате PES"  

Управление проектом    "Управление проектом" 

Обзор проектов в папках    "Обзор проектов в папках" 

Просмотр архивированных 
проектов в папках    "Просмотр архивированных 

проектов" 
Определение 
местоположения 
отсутствующих файлов 

 
  "Определение местоположения 

отсутствующих файлов" 

Изменение региональных 
установок    "Изменение региональных 

установок" 
Открытие проектов в 
BERNINA Embroidery Software    "Открытие проектов в BERNINA 

Embroidery Software" 
Создание новых проектов с 
шаблонами пользователя    "Создание новых проектов с 

шаблонами пользователя" 
Запуск простой и сложной 
сортировки    "Сортировка файлов в папках" 

Распечатка проектов    "Распечатка проектов из 
приложения BERNINA Portfolio" 

Распечатка каталогов 
проектов    "Распечатка каталогов проектов"

Вышивание проектов    "Вышивание проектов" 

Конвертирование файлов 
проектов    "Конвертирование файлов 

проектов" 
Архивирование файлов 
проектов    "Архивирование файлов 

проектов" 
Систематизация проектов в 
папках    "Систематизация проектов в 

папках" 
 
 

 Стандартная функция   ∆ Новая/улучшенная функция    
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ПРИЛОЖЕНИЕ А 

 

 
УСТРАНЕНИЕ ВОЗМОЖНЫХ 

НЕПОЛАДОК 
------------------------------------------- 

 
 

Это приложение должно помочь вам при 
разрешении проблем, связанных с BERNINA 
Embroidery Software. Здесь рассматриваются 
процедуры проверки системных требований 
вашего ПК и настроек, возвращения к 
стандартным параметрам, проверки дисков и присоединений. Кроме того, 
описан порядок протоколирования ошибок и перечислены причины 
появления общих сообщений об ошибках и проблемах. 

 

Устранение проблем в 
BERNINA Embroidery Software 
 
При возникновении проблемы обратитесь за 
помощью к следующей справочной 
документации: 
◄ руководству пользователя по BERNINA 

Embroidery Software – выберите Help > 
Online Manual (или печатной версии)  

◄ онлайновой справке BERNINA 
Embroidery Software – выберите Help > 
Help Topics 

◄ онлайновой справке системы Windows – 
выберите Start > Help 

◄ руководству пользователя по системе 
Windows  

◄ документации, поставленной вместе с 
вашими аппаратными средствами. 

 
Получение помощи 
Если вы не можете сами устранить проблему, 
вам нужно обратиться к вашему дилеру. 
Перед тем, как обращаться за помощью, 
проверьте, соответствует ли ваш компьютер 
системным требованиям и проведите проверки 
согласно разделам Сообщения об 
аппаратном ключе и Общие проблемы в этом 
приложении. 
 

Возврат к заводским 
настройкам 
 
Если вы произвели изменения в стандартных 
установках программного обеспечения и вы 
хотите вернуться к заводским настройкам, 
используйте программу Revert. 
 
Как возвратиться к заводским 
настройкам 
1 Закройте BERNINA Embroidery Software. 
2 Нажмите на панели задач Windows кнопку 

Пуск (Start) и выберите Программы 
(Programs) > BERNINA Embroidery Software > 
Revert. 

 Откроется диалоговое окно Revert to Factory 
Template (Возврат к заводским настройкам).  

           
3 Выберите опции, которые вы хотите вернуть 
к заводским настройкам. 
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Примечание: Учтите, что возврат к 
стандартным установкам удалит любые 
изменения, которые вы внесли в настройки 
стилей, шаблонов и аппаратных средств. 
Новые настройки стилей, шаблонов и 
аппаратных средств останутся 
действующими, если они были сохранены 
отдельно. 

4 Нажмите кнопку ОК. 
Выбранные опции будут возвращены к 
заводским настройкам. 

 
Примечание: В этом случая сообщение о 
подтверждении не появляется. 

 
Характеристики компьютера 
Проверьте, соответствует ли Ваш ПК системным 
требованиям. Проверьте центральный 
процессор и оперативную память, а также 
свободное пространство на жестком диске. В 
таблице приведены минимальные системные 
требования. 
 
Аппаратные 
средства Минимальные требования 

Центральный 
процессор 

Single Core 1 ГГц) или более 
производительный процессор 

Операционная 
система 

Windows XP® SP2 (Home или 
Professional)  

Подключение 
к Интернету 

Опционально: Для доступа к 
сайту Bernina для регулярной 
информации о программных 
продуктах и обновления 

Web-браузер Internet Explorer 6.х  
Память 1 Гб для многократных 

приложений  
Свободное 
пространство 
на жестком 
диске 

30 Гб перед инсталляцией 

Свободное 
дисковое 
пространство 
 

2ГБ, или более 10 % от общего 
объема жесткого диска, смотря 
что больше 

Дисковод Для DVD-ROM для инсталляции 
ПО 

Графическая 
карта 

Поддержка High Color (16-bit) и 
высокая разрешающая 
способность – по меньшей мере 
1024 x 768 

Монитор 15" или больше для 
оцифровывания на экране  

 

 
Аппаратные 
средства Минимальные требования 

Порт USB Выделенный порт USB для 
защитного ключа 
Дополнительный порт USB для 
подключения прибора 
BERNINA Reader/Writer Box или 
для прямого подключения 
вышивальной машины  

Последователь-
ные порты 

Дополнитнльнвый 
последовательный порт для 
подключения прибора 
BERNINA Reader/Writer Box 
(опционально) 

Сканер Совместимый с  
MS Windows® XP 

Принтер Совместимый с  
MS Windows® XP 

Мышь Совместимый с  
MS Windows® XP 

Звуковая карта Не требуется 

 
 
Проверка характеристик 
центрального процессора и 
оперативной памяти 
Проверьте характеристики центрального 
процессора и оперативной памяти и версию 
системы Windows, чтобы убедиться, что они 
соответствуют требованиям программного 
пакета BERNINA Embroidery Software. Подробнее 
см. в разделе Рекомендуемые 
характеристики компьютера. 
 
 
Как проверить характеристики 
центрального процессора и оперативной 
памяти 
1 На рабочем столе Windows щелкните правой 

кнопкой мыши по значку My Computer (Мой 
компьютер) т выберите Properties 
(Свойства).. 

 Откроется диалоговое окно System Properties 
(Свойства системы) на закладке General 
(Общие). 

2 Проверьте версию Windows, тип процессора 
и объем оперативной памяти. 

 
Проверка свободного пространства 
на жестком диске 
Проверьте, имеется ли на жестком диске 
свободное пространство, достаточное для 
эффективной работы BERNINA Embroidery 
Software. Подробнее см. в разделе 
Рекомендуемые характеристики 
компьютера. 
 
Как проверить свободное пространство 
на жестком диске 
1 Щелкните дважды на значку My Computer на 

рабочем столе Windows. 
 Откроется диалоговое окно My Computer. 
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2 Щелкните правой кнопкой мыши по значку 

жесткого диска (обычно это диск C:) и 
выберите Properties. 

 Откроется диалоговое окно Properties 
(Свойства) на закладке General (Общие). 

 На этой закладке указывается общий объем 
жесткого диска и его свободное 
пространство. Оно должно быть больше 100 
Мб или 10 % общего объема жесткого диска, 
при этом нужно принимать в расчет большее 
значение. 

 
Восстановление соединения 
BERNINA Portfolio с ПО 
BERNINA Embroidery Software  
Иногда между программой BERNINA Portfolio и 
BERNINA Embroidery Software отсутствует связь. 
Для выяснения причины проблемы поступайте 
следующим образом. 
 
Как восстановить соединение BERNINA 
Portfolio с BERNINA Embroidery Software 
1  Проверьте, подсоединен ли ваш аппаратный 

ключ (dongle). 
2  Закройте BERNINA Embroidery Software. 
3  Если проблема не будет устранена, 

переустановите BERNINA Embroidery 
Software. снова запустите ПО и откройте 
BERNINA Portfolio.  

Восстановление файлов после 
сбоев аппаратных средств или 
программного обеспечения 
 
После сбоев программного обеспечения или 
аппаратных средств обычно создаются файлы 
восстановления. При перезапуске BERNINA 
Embroidery Software после такого сбоя проект, 
над которым вы работали автоматически 
открывается или, если включена функция 
автосохранения, открывается резервная копия 
файла. Если открывается резервная копия, то 
файл следует сохранить с новым именем с 
расширением ART. 
 
Примечание: Не сохраняйте копию в папке 
Backup, в противном случае она будет удалена. 
 
Как только файл восстановления будет сохранен 
и переименован с расширением .ART, сотрите из 
памяти файлы восстановления. 

 
Как восстанавливать файлы после 
сбоев аппаратных средств или 
программного обеспечения 
1 Запустите программу Windows Explorer 
(Проводник Windows). 
2 Откройте папку ..\Program 
Files\BERNINA\Embroidery Software 
3 Откройте папку Backup. 

 
 
4 Выберите BAK-файл и щелкните по нему 
правой кнопкой мыши. 
5 Выберите Rename (Переименовать) из 
всплывающего меню.  
6 Замените расширение BAK на ART. 
7  Запустите BERNINA Embroidery Software. 
8  Откройте новый файл в BERNINA Embroidery 
Software. 
9  Командой Save As сохраните файл в другом 
месте, но не в папке Backup. 
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Неисправимые ошибки 
Проблема Сбой системы с сообщением о 

неисправимой (‘unrecoverable’) 
ошибке.  

Причина Проект, который вы пытаетесь 
открыть, испорчен. 

Рекомендация Удалите любые файлы в папке 
C:..\Program 
Files\BERNINA\Embroidery 
Software 6\Recover, используя 
служебную программу Purge 
Recovery, или вручную через 
Windows Explorer, затем 
перезапустите BERNINA 
Embroidery Software. Вы 
можете также удалять файлы 
через Windows Explorer. 
Подробнее см. в разделе 
Удаление файлов 
программой Delete Recovery. 

 
Удаление файлов программой Delete 
Recovery 
Вы можете удалять испорченные файлы, 
пользуясь служебной программой Delete 
Recovery (Удаление файлов восстановления). 
Эта программа удаляет файлы в папках 
C:..\Program Files\BERNINA\Embroidery Software 
6\Recover и C:..\Program 
Files\BERNINA\Embroidery Software 6\Backup.  
Кроме того, необходимо периодически удалять 
файлы резервных копий, созданные программой 
Auto Save (Автосохранение). 
 
Примечание: Некоторые файлы, такие как MLG- 
и DMP-файлы, могут со временем накапливаться 
и занимать много места на жестком диске. Вы 
можете удалять их вручную из Windows Explorer. 
 
Как удалять файлы программой Delete 
Recovery 
1 Закройте BERNINA Embroidery Software. 
 BERNINA Embroidery Software должна быть 

закрыта перед удалением резервных копий 
или файлов восстановления, в противном 
случае вы НЕ сможете удалить эти файлы. 

2 Нажмите на панели задач Windows кнопку 
Пуск (Start) и выберите Программы 
(Programs) > BERNINA Embroidery Software > 
Delete Recovery Files. 

 Откроется диалоговое окно Purge Recover 
and Backup Directories. 

3 Выберите Delete Backup Files, если вы хотите 
удалить резервные файлы. 
   

 
 
4 Нажмите кнопку ОК. 
Если некоторые файлы не могут быть удалены, 
то появится соответствующее сообщение. 
Удалите эти файлы из папок C:..\Program 
Files\BERNINA\Embroidery Software 6\Recover и 
C:..\Program 
Files\BERNINA\Embroidery Software 6\Backup  
вручную, выбрав их в Проводнике Windows 
(Windows Explorer). 
 

Совет: Если ошибки не будут устранены, 
попытайтесь вернуться к заводским 
настройкам. Подробнее см. в разделе 
Возврат к заводским настройкам. 
 

Сообщения об аппаратном 
ключе  
 
В этом разделе описываются сообщения, 
относящиеся к аппаратному ключу. Большинство 
сообщений об аппаратном ключе вызваны 
неправильным соединением, неправильно 
введенными кодами доступа или взаимными 
помехами или конфликтами с другими 
аппаратными устройствами компьютера. 
Для предупреждения ошибок, связанных с 
аппаратным ключом, введите коды доступа 
сразу же после их получения. Если вы 
пропустите любой из кодов доступа, функции 
могут быть недоступными или же BERNINA 
Embroidery Software полностью перестанет 
работать. 
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Неправильный код доступа 
 
Сообщение  Invalid Access Code 

Неправильный код доступа 
Причина •  Коды доступа, которые вы 

пытаетесь ввести, не 
соответствуют вашему 
аппаратному ключу. 

•  Вы допустили ошибку при 
вводе кодов. 

Рекомендация Проверьте ID-код по таблице 
кодов доступа, чтобы увидеть, 
соответствует ли он ID-коду в 
диалоговом окне Security Dialog.
При несоответствии запишите 
серийный номер вашего 
аппаратного ключа и текущий 
ID-код и свяжитесь с вашим 
дистрибьютором.  

 
Установка драйвера аппаратного 
ключа 
Если ваша система не может обнаружить 
подсоединенный аппаратный ключ, вам может 
потребоваться переустановить его драйвер. 
 
Как установить драйвер аппаратного 
ключа 
1 Нажмите на панели задач Windows кнопку 

Пуск (Start) и выберите Run (Выполнить). 
 Откроется диалоговое окно Run (Запуск 

программы). 
2 В поле Open (Открыть) введите: 
 C:..\Program Files\BERNINA\Embroidery 
Software 6\BIN\haspdinst.exe -i -kp -av 
 
3 Нажмите кнопку ОК. 

Появится сообщение, подтверждающее, что 
драйвер аппаратного ключа успешно 
установлен. 

4 Перезагрузите компьютер. 

 
Поврежденный продукт 
 
Сообщение  Invalid product 

Поврежденный продукт 
Причина Аппаратный ключ не может 

быть обнаружен или он 
поврежден. 

Рекомендация Проверьте установку 
аппаратного ключа, чтобы 
удостовериться, что он 
правильно вставлен. Свяжитесь 
со своим дистрибьютором, 
сообщив серийный номер 
аппаратного ключа. 

 
Ошибка защиты 
 
Сообщение  Security Device Not Found (-3) 

Аппаратный ключ не обнаружен 
(-3) 

Причина Повреждение аппаратных 
средств или аппаратного ключа 
или неправильно вставлен 
аппаратный ключ. 

Рекомендация Проверьте установку 
аппаратного ключа, чтобы 
удостовериться, что он 
правильно вставлен. 
Попытайтесь использовать 
другой порт и перезагрузите 
программное обеспечение. 
Если это не приведет к успеху, 
свяжитесь со своим 
дистрибьютором, сообщив 
серийный номер аппаратного 
ключа. 

Общие проблемы 
 
В этом разделе рассматриваются общие 
проблемы, которые могут возникнуть при работе 
с проектами. 
 
Размеры проекта 
 
Проблема Неправильные размеры 

проекта. 
Причина Если размеры проекта слишком 

большие или слишком малые, 
причина может заключаться в 
неправильном выборе системы 
единиц измерения. Система 
единиц измерения 
устанавливается в диалоговом 
окне Стандарты (Regional 
Settings) системы Windows. 

Рекомендация Измените единицы измерения в 
системе Windows. Вы Выберите 
опцию Пуск (Start) > Настройка 
(Settings) > Панель управления 
(Control Panel) > Язык и 
Стандарты (Regional and 
Language Options) из меню 
кнопки Пуск. 
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Несовместимые результаты вывода 
 
Проблема Проблемы при передаче проектов 

в вышивальные машины для 
вышивания. Несовместимость 
считывания и записи. 

Причина Проблемы с последовательным 
или USB портом. 
Несовместимость процессов 
считывания и записи может быть 
вызвана неправильной настройкой 
порта в операционной системе. 
Другими возможными причинами 
может быть несовместимость 
машины с версией программного 
обеспечения. В этом случае 
свяжитесь с вашим дилером. 

РекомендацияИзмените настройки порта. 
 
Отсутствие кнопок на панели 
инструментов 
 
Проблема Отсутствие кнопок на панели 

инструментов. 
Причина Слишком низкое разрешение 

экрана. Вирус в компьютере. 
РекомендацияИзмените разрешение экрана до 

800x600 или выше. Запустите 
антивирусную программу. 

 
 
Ошибки типа Exception Access 
Violation 
Сообщение об ошибке ‘Exception Access 
Violation’ может появляться при 
масштабировании, использовании текста, при 
печати или сканировании, сохранении проектов 
или просмотре таблицы Color Film. Эта 
проблема в общем случае относится к драйверу 
видеоадаптера и/или к самому видеоадаптеру. 
Попытайтесь последовательно использовать 
следующие способы решения проблемы. 

 
Сообщение Exception access violation при 
запуске 
 
Проблема Сообщение об ошибке 

‘Exception Access Violation’ 
появляется при  запуске 
BERNINA Embroidery Software. 

Причина Испорченный файл проекта в 
папке RECOVER или 
испорченный файл ..\Program 
Files\BERNINA\Embroidery 
Software 6\RES\defaults.dfl. 

Рекомендация Удалите любые файлы в папке 
.....\Program 
Files\BERNINA\Embroidery 
Software 6\RECOVER. Если 
BERNINA Embroidery Software 
все еще не запускается, 
используйте MS Windows® 
Explorer, чтобы скопировать 
стандартный файл 
...\BIN\defaults.dfl и вставить его 
в папку ...\RES folder для 
замены испорченного файла 
defaults.dfl. Это потребует 
перезапуска BERNINA 
Embroidery Software для ‘новой 
установки. 

 
Другие случаи появления сообщения 
Exception Setting Violations 
 
Проблема Сообщение об ошибке 

‘Exception Access Violation’ 
появляется при 
масштабировании, 
использовании текста, при 
печати или сканировании, 
сохранении проектов или 
просмотре таблицы Color Film. 
 

Причина Эта проблема в общем случае 
относится к драйверу 
видеоадаптера и/или к самому 
видеоадаптеру. 
 

Рекомендация Попытайтесь последовательно 
использовать перечисленные 
способы решения проблемы. 
Подробнее см. в разделе 
Проверка дисплейного 
адаптера. См. также раздел 
Ошибки типа Exception 
Access Violation 
 

 
Проверка видеоадаптера 
 

Используйте приложение Система в 
Панели управления, чтобы проверить 

видеоадаптер и драйверы. 
 
Используйте следующую процедуру, чтобы 
определить, какая модель видеоадаптера у вас 
установлена и какие драйверы имеются для 
видеоадаптера. 
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Как проверить видеоадаптер 
1  Из панели задач Windows выберите Пуск > 

Панель управления. 
2  Дважды щелкните по значку Система. 
 Откроется диалоговое окно Свойства 

системы (System Properties). 
3  Выберите опцию Диспетчер устройств 

(Device Manager). 
 Откроется диалоговое окно Диспетчер 

устройств (Device Manager). 

 
 
4  Щелкните по узлу Видеоадаптеры 

(Adapters) для открытия. 
5  Запишите название видеоадаптера из списка.  
6  Щелкните правой кнопкой и выберите 

Свойства. 

 
7  Выберите закладку Драйвер (Driver) и 

запишите данные драйвера. 
8  Щелкните по опции Сведения (Driver Details) 

 
 

 
9  Запишите сведения о Поставщике (Provider) 

и Версии файла (File Version).  

 
 

10  Закройте диалоговое окно и выйдите из 
Панели управления.  

11  Проверьте веб-сайт производителя 
видеоадаптера, возможно там имеется более 
поздняя версия драйвера.  Подробнее см. в 
разделе  
Веб-сайты с последними версиями 
видеоадаптеров. 

 
Веб-сайты с последними версиями 
видеоадаптеров 
Некоторые общие проблемы связаны с 
видеоадаптером вашего ПК. Наиболее часто они 
связаны со встроенными графическими 
микросхемами. 
Проверьте веб-сайты производителей 
видеоадаптеров или драйверов, позволяющие 
загрузить новейшие версии драйверов 
видеоадаптеров. Если там найдется новейший 
драйвер, загрузите и установите его. Обычно 
производитель предлагает загрузить драйвер 
бесплатно. Вот некоторые популярные веб-
сайты производителей драйверов 
видеоадаптеров: 
◄  www.ati.com 
◄  www.nvidia.com 
◄  www.matrox.com 
◄  www.diamondmm.com 
◄  www.download.com 
◄  www.intel.com 
◄  www.helpdrivers.com 
◄  www.neomagic.com 
◄  www.oaktech.com 
◄  www.s3graphics.com 

Запишите 
название 
адаптера 

Кнопка 
"Сведения о 
драйвере"

Запишите 
поставщика и 
версию файла 
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◄  www.sis.com 
◄  www.tridentmicro.com 
◄  www.tucows.com 
◄  www.windrivers.com 
Если ваша видеокарта встроена в системную 
плату, обратитесь к веб-сайту производителя 
системной платы. 
 
Уменьшение графического ускорения 
Если вы уже установлена последняя версия 
драйвера или новый драйвер не разрешил 
проблему, вы можете уменьшить графическое 
ускорение системы MS Windows®. 
 
Как уменьшить графическое ускорение 
1  Перейдите к опции Аппаратное ускорение 

(Hardware Acceleration) в системе настроек 
Win 2000/XP: 

◄ Щелкните правой кнопкой по рабочему столу 
и выберите Свойства.  

◄ Выберите закладку Параметры (Settings) и 
щелкните по Дополнительно (Advanced). 

 Выберите закладку Диагностика 
(Troubleshoot) 

 
 
2  Уменьшите аппаратное ускорение (hardware 

acceleration) на одно деление. 
 
3  Щелкните по ОК. 
 Вам будет предложено перезагрузить 
компьютер. 

 
4  После перезагрузки MS Windows® 

наблюдайте, как запускается ПО. Если 
проблема не будет устранена, попытайтесь 
уменьшить ускорение еще на одно деление. 
Обычно вам не потребуется уменьшать 
ускорение больше, чем на два деления, для 
устранения проблемы. Однако в крайних 
случаях приходится уменьшать ускорение до 
‘Нет’.  

 
Установка другой модели 
видеоадаптера 
В очень редких случаях обновление драйвера 
видеоадаптера и/или уменьшение графического 
ускорения не приводит к решению проблемы. 
Единственным решением является установка 
другой модели/марки видеоадаптера. BERNINA 
International AG может посоветовать, какой тип 
видеоадаптера следует использовать. Если у 
вас есть второй компьютер с другим 
видеоадаптером, мы рекомендуем поменять их 
местами. Нередко ‘проблемный’ адаптер 
прекрасно работает на другом компьютере. 
 
 

Уменьшение 
аппаратного 
ускорения 



Приложение В: Советы и рекомендации 
 

BERNINA® Вышивальное ПО Версия 6 433

 
ПРИЛОЖЕНИЕ B 

 

 
СОВЕТЫ И РЕКОМЕНДАЦИИ 

------------------------------------------- 

 
В этом приложении собраны советы и подсказки, 
которые позволят вам извлечь максимум пользы от 
работы с программой BERNINA Embroidery 
Software и от вашей домашней вышивальной машины 
BERNINA. Сюда вошли советы по стабилизации 
проектов, заправке их в пяльцы, рекомендации по 
использованию ниток и игл, по вышиванию букв и 
аппликаций, по качеству стежков, разработке проектов и 
по многим другим вопросам. 
 
 
1 При вышивании на эластичных тканях 
обязательно используйте отрезаемый 
стабилизатор. 
 
2 Не растягивайте ткань при заправке ее в 
пяльцы. 
 
3 Обязательно выполните пробную 
вышивку вашего проекта, прежде чем 
вышивать ее окончательно. Для пробной 
вышивки используйте тот же тип ткани, 
стабилизатора и ниток. 
 
4 По завершении вышивки отрежьте или 
оторвите излишки стабилизатора, 
придерживая ткань на коленях перед собой. 
Это позволит избежать V–образных порезов 
ткани при отрезании излишков. 
 
5 При отрывании излишков стабилизатора 
будьте осторожны, чтобы не порвать нитки 
стежков. Всегда отрывайте “наружу”, а не 
“вовнутрь” вышивки.  
 
6 По возможности всегда заправляйте в 
пяльцы как ткань, так и стабилизатор. 
 
7 Полиэстровые вышивальные нитки 
прочнее вискозных, лучше сохраняют цвет, 
устойчивы к хлорным отбеливателям, к 
ультрафиолетовому излучению. Они не 
окрасят ткань и сами не окрасятся. 
 

8 При вышивании на полотенцевой или 
другой ворсистой ткани используйте 
стабилизирующее покрытие ткани 
растворимым в воде веществом. Это 
позволит избежать “неопрятных” стежков и 
удержит стежки на лицевой стороне ткани. 
 
9 При работе с текстилем нужно 
использовать острые иглы. Острое острие 
иглы протыкает волокна ткани, обеспечивая 
чистые, четкие края вашей вышивки. 
 
10 Иглы с закругленным острием нужны для 
работы с трикотажем.  Скругленное острие 
иглы проходит между волокнами трикотажа, 
не оставляя повреждений. 
 
11 Содержите вышивальную машину в 
чистоте, чтобы она работала ровно. 
Следуйте инструкциям изготовителя по 
чистке и смазке машины.  Если надо -  
покажите машину специалисту. Если вы 
позаботитесь о вашей машине – она 
позаботится о вас.  
 
12 Если вы хотите сделать вышивку на 
груди слева – положите сперва предмет 
одежды на плоскую поверхность. 
Проведите воображаемые линии вниз от 
середины плеча и поперек от середины 
рукава. Центр вышивки должен 
располагаться на пересечении этих линий.   
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13 Если вы хотите сделать вышивку на 
одежде посередине груди – центр ее 
должен располагаться на пересечении  
вертикальной центральной линии и 
поперечной линии от середины рукава. 
 
14 Следите, чтобы внутренний обруч пялец 
был полностью заправлен во внешний.  
Поверхность ткани, заправленной в пяльцы, 
должна быть плоской, чтобы стежки 
формировались правильно. 
 
15 Шпульную нитку не следует обрезать 
слишком коротко. Оставьте небольшой 
хвостик.  Он поможет избежать ослабления 
передних стежков. Если стежки легли 
рядом, не трогайте их и не обрезайте. 
 
16 Не забывайте про клеющий слой на 
ваших проектах. Он соединяет ткань со 
стабилизатором и поможет еще больше 
стабилизировать проект. 
 
17 Буквы не обязательно делать 
гладьевыми стежками.  Если вышивка 
делается на спортивной сумке, которую 
будут активно использовать, лучше уж не 
применяйте гладьевые стежки. 
 
18 Поверьте иглу, проткните ей ткань. Она 
должна легко протыкать ткань, не оставляя 
дырок.  Для плотных тканей лучше 
использовать тонкие иглы. 
 
19 На более плотных тканях лучше делать 
более крупные буквы, на менее плотных – 
лучше более мелкие. 
 
20 Попробуйте изменить цветовую гамму 
для оживления старого проекта. 
Попробуйте сделать все в одном цвете, или 
сократите цветовую гамму до 2-3 цветов. 
Получится совершенно новый вид. 
 
21 Для оптимального сочетания разных 
типов ниток используйте многокатушечный 
катушкодержатель Multiple Spool Holder. 
 
22 Машины класса Bernina artista позволяют 
перематывать дополнительные шпульки в 
процессе вышивания. 
 
23 Для упрощения заправки ниток в 
вышивальную машину используйте 
функцию ‘hoop relocator’. 
 
24 Не забудьте сгруппировать проект при 
его копировании и вставке. Чтобы 
проверить, нет ли дополнительных слоев в 
проекте, используйте функцию color film. 
 
25 Печатайте шаблон вашего проекта 
используя пяльцы с осями x-y. Это даст две 

контрольные точки для фиксации 
положения проекта – начальную и 
центральную. 
 
26 Если стартовая точка совпадает с 
центром проекта, сдвиньте ее с помощью 
функции Arrange>Start and End, чтобы 
вторая контрольная точка послужила 
точному размещению проекта на машине. 
 
27 Отключите пяльцы при 
позиционировании большого проекта, чтобы 
не  отвлекаться на движения пялец  при 
добавлении объектов к композиции. Когда 
проект будет собран как надо, включите 
отображение пялец, чтобы проверить, как 
проект ложится в поле вышивки. 
 
28 Если вы позиционируете рисунок 
вручную, оцифруйте линию внутренней 
границы пялец. При автоматической 
центровке на вышивальной машине, эта 
линия поможет удержать рисунок в нужном 
положении. При вышивании просто 
пропускайте эту линию. 
 
29 Оцифровка контрольных линий поможет 
разместить образцы на вашем проекте. 
Используйте линии на шаблоне для точного 
размещения его на вашей работе. 
 
30 Стабилизация очень важна при 
вышивании. Понимание того, сколько и 
какого типа стабилизатора надо 
использовать, приходит с опытом. 
 
31 Работая над проектом не забывайте 
сохранять его (Save As). Используйте Save 
As сразу, как только откроете файл проекта, 
чтобы не стереть случайно исходный 
образец.  
 
32 Очень важны разметочные линии на 
ткани. Неправильная заправка ткани в 
пяльцы может испортить все на свете. 
 
33 Пользуйтесь системой помощи 
‘Help’. 
 
34 С помощью функции Stitch Re-sequence 
вы сможете настроить оптимальную 
последовательность вышивки, с 
наименьшим числом смен ниток и 
перезаправки пялец. 
 
35 Можно быстро сделать квилт-ярлык с 
помощью инструмента box tool, выбрав 
подходящий из множества образцов 
контуров. 
 
36 В нижнем правом углу экрана всегда 
отображается счетчик стежков, высота и 
ширина проекта. 
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37 Ваши проекты можно легко отправить на 
вышивальную машину Bernina. 
 
38 Переслать проект с компьютера на 
машину можно разными способами. 
 
39 Вы можете задавать и менять углы 
заполняющих стежков. 
 
40 С помощью инструмента Remove 
Overlaps можно удалить лишние стежки. 
 
41 Эластичные буквы помогут создать 
уникальные проекты. 
 
42 Ширину строчки и интервалы между 
декоративными краеобметочными стежками 
можно установить вручную. 
 
43 Функция Undo – ваш помощник. Вы 
можете отменять изменения до 256 раз 
перед последним сохранением. 
 
44 Объекты выделяются по щелчку мыши. 
Если при этом удерживать клавишу #2 
можно последовательно перебирать 
объекты, расположенные слоями. 
 
45 В режиме редактирования можно 
перемещать начальную и конечную точку 
объекта с помощью активных элементов – 
ромбика (начальная) и крестика (конечная). 
 
46 Имеется 30 видов шаговых заполнений. 
 
47 Нажмите клавишу (.) на клавиатуре – 
отобразятся на экране точки прохождения 
иглы. 
 
48 Можно настроить параметры слоя 
подложки перед оцифровкой. 
 
49 К объектам можно применять функцию 
компенсации натяжения (pull compensation).  
 
50 Аппликацию можно выполнить, вырезав 
заранее или обрезав уже на месте. 
 
51 Создать продвинутые поможет новая 
функция незамкнутых аппликаций (open 
curve applique). 
 
52 К аппликациям, созданным на 
компьютере, можно добавлять ткани. 
 
53 Гладьевые аппликации легко 
преобразуются в декоративные стежки. 
 
54 В системе помощи есть изображения 
всех шрифтов с указанием рекомендуемых 
максимальных и минимальных размеров.   
Рекомендуем их распечатать для справки. 
 

55 You can adjust the Можно менять 
расстояния между основаниями букв. 
Особенно полезная функция, когда надпись 
располагается по дуге. 
 
56 С помощью инструмента wreath tool 
можно объединять перекрывающиеся 
объекты в один. 
 
57 Можно одновременно вставлять 
многочисленные образцы из вашей 
коллекции. 
 
58 С помощью функции color film можно 
просмотреть образец цвет за цветом. 
 
59 С помощью функции color film можно 
менять порядок стежков. 
 
60 С помощью функции color film можно 
легко менять цвета в вашем проекте. 
 
61 Функция Slow redraw позволяет увидеть 
на экране, как будет выполняться вышивка. 
 
62 Функция polygon select позволяет легко 
выделить нужную часть проекта. 
 
63 Функция blackwork run позволяет легко 
начертить контур проекта. 
 
64 С помощью функции wreath tool можно 
вышивать красивые надписи и числа 
 
65 В режиме DesignerPlus все шрифты типа 
True Type Fonts автоматически 
оцифрованы. 
 
66 Можно задать радиус дугообразной 
базовой линии для вашей надписи. 
 
67 Файлы с рисунками категории ‘A’ 
сохраняют целостность при изменении 
масштаба, предоставляя больше 
возможностей редактирования. 
 
68 Есть возможность выравнивать 
отобранные объекты по краям (левому, 
правому, нижнему, верхнему) или по центру 
выбранного объекта. 
 
69 Инструмент выравнивания выравнивает 
все выделенные объекты по последнему 
выбранному. 
 
70 Вы можете добавлять новые пяльцы в 
программу и сохранять их для 
последующего использования. 
 
71 Сохраняйте отсканированные рисунки в 
программе с дополнительными вышивками 
вокруг рисунка. 
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72 В системе помощи есть список “горячих 
клавиш”, помогающих быстрее обращаться 
к функциям программы. 
 
73 Функция Portfolio позволяет организовать 
ваши образцы в разных форматах. 
 
74 Функция Portfolio позволяет 
просматривать образцы в разных режимах: 
только рисунки, рисунки с коментариями, 
списком.  
 
75 Функция Portfolio позволяет сортировать 
файлы образцов по именам, размерам и 
дате. 
 
76 Функция Portfolio позволяет распечатать 
каталог образцов, отображая их на вашем 
РС. 
 
77 Функция Portfolio позволяет 
архивировать и разархивировать файлы с 
образцами. 
 
78 Функция Artistic View позволяет 
просмотреть вид образца, как он будет 
вышит. В режиме Artistic View можно 
редактировать и оцифровывать образцы. 
 
79 Можно распечатать образец аппликации 
с помощью инструментария функции 
аппликаций программы BERNINA 
Embroidery Software. 
 
80 На образцах аппликаций можно 
настраивать ширину строчки и интервалы 
между декоративными стежками. 
 
81 Когда вы закончили работу над 
аппликацией (аппликациями), программа 
автоматически создаст линию ее 
размещения, точки закрепления и 
покрывающие стежки с цветными 
позициями остановки. 
 
82 Инструмент partial applique позволяет 
удалить перекрывающиеся стежки на 
аппликации. 
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ПРИЛОЖЕНИЕ C 

 

 
ОБРАЗЦЫ АЛФАВИТОВ 

------------------------------------------- 
 
 
 
Образцы алфавитов для вышивания, приводимые в этом приложении, являются составной 
частью вашей программы BERNINA Embroidery Software, но не все виды входят в состав 
каждого уровня. 
 
Для получения самых лучших результатов при вышивании не выходите за пределы 
рекомендуемых максимальных и минимальных размеров, указанные для шрифта каждого 
алфавита. Имейте в виду, что рекомендуемые максимальные высоты относятся к буквам 
ЗАГЛАВНЫМ (ВЕРХНЕГО РЕГИСТРА). Большинство вышивальных алфавитов оцифрованы на 
основе некоторого шрифта типа TrueType Font (TTF), некоторые из которых имеют прописные 
буквы (нижнего регистра, например, а или с) составляющие по высоте примерно 70% от высоты 
заглавных букв.  В результате такие буквы могут оказаться слишком маленькими для 
вышивания при минимальных размерах. Может потребоваться несколько увеличить размер 
прописных букв, чтобы они хорошо вписались в вышивку.  
  
Указания по применению вышиваемых алфавитов см. в разделе Добавление текста к 
проектам вышивки. 
Для получения самых лучших результатов всегда проверяйте правильность выбора типа 
стабилизирующих стежков. 
Кроме стабилизации, стабилизирующий слой стежков помогает как-бы “приподнять” буквы над 
тканью. Требуемый тип стабилизирующего слоя определяется размером вышиваемых букв.  
Для мелких, узких букв стабилизирующие стежки могут не потребоваться, в зависимости от 
размеров букв и вида материала, на которых они будут вышиты.  
Если используются автоматические стабилизирующие стежки, они будут видны за пределами 
колонок вышивки. Для букв с размерами менее 5 мм применять стабилизирующие стежки не 
следует. Для букв с размерами от 6 мм до 10 мм можно использовать центрованные 
стабилизирующие стежки. Для букв с размерами более10 можно использовать краевые 
стабилизирующие стежки.  
См. также Стабилизация ткани стежками и Отключение функции автоматической 
стабилизации ткани для мелких букв. 
 
Совет: Вы можете создавать специальные символы из любого алфавита, удерживая нажатой 
клавишу Alt на клавиатуре и набирая 0 (ноль) и код символа на цифровой клавиатуре. 
Например, чтобы выбрать è с кодом 232, наберите Alt + 0232. Символ появится, как только вы 
отпустите клавишу Alt. В таблице символов вы найдете коды для всех символов. 
 См. также Добавление специальных шрифтовых знаков. 
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Abby Script

Abby Script is a traditional one-color script alphabet. It is great for names. 
Use extra pull compensation at smaller sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm

Maximum 2.8 in 70 mm
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Alice

Alice is a traditional decorative style suitable for initials/monograms and 
personalization.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm

Maximum 2.0 in 50 mm
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Anniversary

Anniversary is a stylish script with fine curves and flourishes. It is popular 
for personalizing garments. Use extra pull compensation at smaller sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm

Maximum 3.0 in 75 mm
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Bamboo

Bamboo is an oriental style alphabet. It can be used as a decorative 
alphabet by restaurants or martial arts clubs to convey an Asian influence.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm

Maximum 1.6 in 40 mm
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Blackboard

Blackboard is a classic serif-style alphabet. It has been popular for many 
years and is common in logos and educational designs.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm

Maximum 2.0 in 50 mm
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Bodoni

Bodoni is a classic, high-contrast alphabet best suited to larger sizes or with 
very stable fabric.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 7 mm

Maximum 2.0 in 50 mm
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Border-CAPS

Border-CAPS is a two-color block alphabet. It is used on sporting, school or 
college wear.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and 
European/special characters

Colors 2 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13mm

Maximum 1.5in 38mm
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Broadsheet

Broadsheet has a Satin outline around the outside edge of the letter shapes. 
The letters have solid, heavy appearance, with a serif-effect. This alphabet 
should be used in larger sizes.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and 
European/special characters

Colors 1 color

Stitching CAPS - Satin

Recommended letter height
Minimum 1.2 in 30 mm

Maximum 3.0 in 75 mm
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Castle

Castle is a classic romantic alphabet suitable for monograms or to convey a 
medieval or old world feel to restaurants or advertising material.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.75 in 10 mm

Maximum 1.6 in 40 mm
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Centurion

Centurion is a compact alphabet with strokes curving into serifs 
perpendicular to the letter strokes. It is more suited to medium-larger sizes. 

Alphabet contains
Characters A - Z, a - z, 0 - 9
Punctuation and symbols
European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm

Maximum 2.4 in 60 mm
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Chicago

Chicago is a modern very squarish athletic-style alphabet, with half-serifs. 
Its solidity makes it well suited to large lettering on heavier fabrics, such as 
athletic wear and jeans.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm

Maximum 3.0 in 75 mm
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Childs Play

Childs Play is a fun alphabet, based on children’s handwriting.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm

Maximum 1.2 in 30 mm
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Christopher

Christopher is a very rounded style. It suits children's wear, sportswear and 
modern designs.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm

Maximum 1.2 in 30 mm
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Craft

Craft is a modern narrow upright block, more suited for use on stable 
fabrics.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.4 in 10 mm

Maximum 2.0 in 50 mm
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Creative Cross

Creative Cross is decorative alphabet which can be used to embellish 
children’s wear. Capital letters include a design whereas the lower case 
letters are plain.

Alphabet contains Letters A - Z are letters with designs, a - z are letters only
Designs only on keys ! " # $ % & ' ( ) * + , - . / 01234567890

Colors Multi-color

Stitching Manual/cross stitches

Recommended letter height
Minimum 1.2 in 30 mm

Maximum 4.0 in 100 mm
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Croissant

Croissant is a specialist fancy style, giving a completely different look from 
most other alphabets. It is suitable for restaurants, homewear and other 
people-oriented designs.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm

Maximum 2.0 in 50 mm
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Cursive

Cursive is a basic script-style alphabet, with simply-formed capital letters. 
The thickness of the strokes is reasonably uniform, making this style usable 
across a wide range of sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm

Maximum 2.4 in 60 mm
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Detex Normal

Detex Normal is a distinctive style. It has squarish letters in upper-case, 
with the effect of an open bar on the left size. It makes an attractive 
monogram.

Alphabet contains
Characters A - Z, 0 - 9
Punctuation and symbols
European/special characters

Colors 1 color

Stitching CAPS - Satin

Recommended letter height
Minimum 0.35 in 9 mm

Maximum 2 in 50 mm
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Diamond2

Diamond2 is a special alphabet which includes two versions of each letter 
for left and right positions, plus a border and flourish for two-letter designs.

Alphabet contains

Left and Right letters for 2-letter monogram, 2 Borders as shown. 
To create a monogram, use upper case for the left letter, and lower 
case for the right letter, and either left square bracket [ or right 
square bracket ] for the border. For example, to create the first 
monogram shown above type Ab[.

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.7 in 18 mm

Maximum 4.0 in 100 mm
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Diamond3

Diamond3 is a special alphabet which includes three versions of each letter 
for left, center and right positions, plus a border and flourish for 3-letter 
designs.

Alphabet contains

Left, Center and Right letters for 3-letter monogram, plus 2 borders as shown. To 
create a monogram, use upper case for the left letter, the symbol key shown 
above for center letter, and lower case for the right letter, with either left square 
bracket [ or right square bracket ] for the border. For example, to create the first 
monogram shown above type A"c[.

Colors 1 color

Stitching Satin

Recommended letter 
height

Minimum 0.7 in 18 mm

Maximum 4.0 in 100 mm
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Drifter

Drifter is a bold, relaxed style, with curves throughout. It has an Art Deco 
feel, and can be used in most situations.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm

Maximum 1.6 in 40 mm
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Easy Appliqué

Easy Appliqué makes appliqué letters which have uneven stroke width and 
rounded serifs. Each letter includes three stitching layers – first a placement 
line, then a zigzag tackdown, and finally a Satin cover stitch.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and 
European/special characters

Colors 1 color (cover stitch)

Stitching Appliqué

Recommended letter height
Minimum 1.2 in 30 mm

Maximum 2.8 in 70 mm
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Eliza

Eliza is a one-color script alphabet designed for monogramming.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.8 in 20 mm

Maximum 3.2 in 80 mm



Appendix C : Alphabet Samples

BERNINA® Embroidery Software : Onscreen Manual  461

Empress

Empress is an elegant calligraphic script style with a rich, classical look and 
small lower-case letters. It is reminiscent of wedding and similar invitations, 
and is suitable for gifts and special occasions.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm

Maximum 2.4 in 60 mm
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Energy

Energy is a fun, fast-paced style, which looks like quickly-written, 
hand-printed notes. It is suitable for larger lettering in youth-oriented 
designs.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm

Maximum 2.4 in 60 mm
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Erica

Erica is a graceful script alphabet based on Espania font and designed for 
monogramming.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.6 in 15 mm

Maximum 2.3 in 55 mm
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Felt Tip

Felt Tip is a Gothic alphabet in the style of historic English fonts. It can be 
applied to gifts and personalised items.

Alphabet contains
Characters A - Z, 0 - 9
Punctuation and symbols
European/special characters

Colors 1 color

Stitching Normal - Satin

Recommended letter height
Minimum 0.4 in 10 mm

Maximum 2 in 50 mm
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Flair Script

Flair Script is a graceful script with added flairs underneath. Flairs either fit 
snugly under the letters or are lowered to accommodate descenders.

Note  For Flair characters type keys as shown. Flairs can be for letters with 
or without descenders. For example, for the first example, type 4 abc[.

Alphabet contains
Characters A - Z, a - z, 0 - 9
Punctuation and symbols
Flair characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.75 in 10 mm

Maximum 3.2 in 80 mm
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Fortress

Fortress is solid block-style alphabet with simple clean lines. It is suitable for 
use on heavier fabrics.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm

Maximum 1.6 in 40 mm
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Greek

Greek is a classic serif-style. It is suited for educational institutions, 
restaurants, and events such as marriages and births in Greek communities.

Alphabet contains Greek letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm

Maximum 2.0 in 50 mm
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Greek Ionic

Greek Ionic is a san-serif style alphabet. As it is an easy to read alphabet, 
it can be applied to a wide range of personal and corporate uses in Greek 
communities.

Alphabet contains Greek letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.4 in 10 mm

Maximum 2.0 in 50 mm
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Guinevere

Guinevere is based on the old writing styles of Welsh and Irish texts. It is 
decorative and suited for a wide range of uses such as souvenirs, linen, 
restaurants, some ethnic designs etc.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm

Maximum 2.0 in 50 mm
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Hebrew 2

Hebrew 2 is a modern square Hebrew alphabet. It is a compact alphabet 
which can be applied to a wide range of uses in Hebrew communities.

Alphabet contains Hebrew letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm

Maximum 1.6 in 40 mm
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Hebrew David

Hebrew David is a modern Hebrew alphabet with rounded letters. As it is an 
easy to read alphabet, it can be applied to a wide range of uses in Hebrew 
communities.

Alphabet contains Hebrew letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm

Maximum 1.6 in 40 mm
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Hiragana

This is a special alphabet with Japanese Hiragana symbols for each letter.

Impact 3D

Impact 3D is a raised 3D alphabet to be stitch out with 3 mm thick foam 
only. It looks good if you follow the recommended lettering heights. It can 

Alphabet contains Japanese Hiragana characters. See print manual Alphabets appendix for 
details of input keys.

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm

Maximum 2.0 in 50 mm
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be applied to items that don’t require frequent washing as this will tend to 
damage the foam.

Alphabet contains Characters A - Z, 0 - 9

Colors 1 color

Stitching Normal - Satin, additional underlay not required

Recommended letter height
Minimum 0.8 in 20 mm

Maximum 1.4 in 35 mm

Special
Foam 3 mm

Thread tension setting -2
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Island

Island is a bold script-style alphabet, with connecting lower-case letters. 
The thickness of the strokes is even throughout. It is popular and versatile. 

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm

Maximum 2.0 in 50 mm
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Jikharev

Jikharev is based on the Russian Cyrillic alphabet. It is easy to read and can 
be used for many purposes, both personal and corporate.

Alphabet contains Russian/Cyrillic letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter 
height

Minimum 0.3 in 8 mm

Maximum 2.0 in 50 mm
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Katakana

This is a special alphabet with Japanese Katakana symbols for each letter.

Alphabet contains Japanese Katakana characters. See print manual Alphabets appendix for 
details of input keys.

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm

Maximum 2.0 in 50 mm
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Ketchikan

Ketchikan is an ornate all caps alphabet which is commonly used for 
restaurant, clothing and other business names where style and fashion are 
important.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and 
European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm

Maximum 1.2 in 30 mm
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Kindergarten Block

Kindergarten Block is a fun alphabet which has many applications for 
children’s wear. 

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and 
European/special characters

Colors 1 color

Stitching CAPS - Satin

Recommended letter height
Minimum 0.4 in 10 mm

Maximum 3.6 in 90 mm
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King Charles

King Charles is a fancy alphabet style with proportionally large lower-case 
and long ascenders. It creates an old-style formal and elegant impression.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm

Maximum 2.0 in 50 mm



Appendix C : Alphabet Samples

BERNINA® Embroidery Software : Onscreen Manual  480

Lazer

Lazer is a modern techno-style alphabet with rounded corners consisting 
only of upper case letters, small and large. It looks good when applied to 
modern, clean designs, particularly with a techno theme.

Alphabet contains
Characters A - Z, a - z, 0 - 9
Punctuation and symbols
European/special characters

Colors 1 color

Stitching Normal - Satin

Recommended letter height
Minimum 0.24 in 6 mm

Maximum 2 in 50 mm
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Lisa

Lisa is a hand-writing style where lower-case letters join together. It is 
popular for monograms, but is not suitable for use with many capital letters 
together.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.50 in 13 mm

Maximum 3.0 in 75 mm
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London

London is an easy-to-read sans-serif style alphabet with large lower-case 
letters. The stylish look suits both corporate and personal text.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm

Maximum 2.0 in 50 mm
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Mandarin

Mandarin is an alphabet consisting of upper-case characters, with an Asian 
influence. It is used for Asian restaurants, martial arts clubs, etc.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and 
European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm

Maximum 2.0 in 50 mm
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Medley

Medley has a hint of serif created by the flared ends of the strokes. It is very 
stylish, and suitable for masculine monograms. 

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm

Maximum 1.6 in 40 mm
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Meegan

Meegan is a one-color script alphabet designed for monogramming.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.6 in 15 mm

Maximum 2.2 in 55 mm
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Neon-CAPS

Neon-CAPS is an alphabet which mimics the effect of neon lights. It can be 
used to give a modern hi-tech look in a wide variety of applications.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and 
European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.7 in 18 mm

Maximum 3.0 in 75 mm
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Nightowl

Nightowl is a modern sans-serif alphabet with a noticeable italic slant and 
rounded ends. It is a popular style for advertising and designs with a 
carefree feeling.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm

Maximum 2.0 in 50 mm
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Olde English

Olde English is based on traditional medieval English calligraphy script. It is 
used for specialist lettering, and is especially popular for school, college and 
university badges.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.5 in 13 mm

Maximum 2 in 50 mm
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Phoebe Curls

Phoebe Curls is an ornamental capital-serif alphabet with floral background 
designed for monogramming.

Alphabet contains Characters A - Z (caps only)

Colors 1 colors

Stitching Satin

Recommended letter height
Minimum 0.6 in 15 mm

Maximum 1.4 in 35 mm
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Prestige

Prestige is a traditional block-style alphabet, popular for corporate logo 
work. It is quite bold and usually does not require additional pull 
compensation. It also works well with enveloping.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 5 mm

Maximum 2.0 in 50 mm
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Quilting Text

Quilting Text gives a feel of hand stitching and is used to personalize blocks 
in quilts. It is a very small alphabet made of simple running stitches, as it is 
required to be subtle and blend into the quilt.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Run stitching

Recommended letter height
Minimum 0.16 in 4 mm

Maximum 0.25 in 6 mm
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Racer

Racer is a streamlined script alphabet with emphasized balled top ends. It 
recalls the chrome-strip lettering used on industrial goods of the 1930s and 
40s, such as enamelled refrigerators and automobile trunks. It looks good 
when applied to racing and sporting uniforms.

Alphabet contains
Characters A - Z, a - z, 0 - 9
Punctuation and symbols
European/special characters

Colors 1 color

Stitching Normal - Satin

Recommended letter height
Minimum 0.3 in 8 mm

Maximum 1.4 in 35 mm
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Roman-Small

Roman-Small is a variant of Times Roman, specifically designed for use in 
smaller sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.2 in 4 mm

Maximum 0.25 in 6 mm
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Rounded Block

Arial Rounded is based on the widespread 20th century realist sans-serif.

Russian Textbook

As the name suggests, Russian Textbook is a standard textbook font based 
on Russian/Cyrillic letters, suitable for general use in logos, etc.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm

Maximum 1.8 in 45 mm
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Alphabet contains Russian/Cyrillic letters, 0 - 9, and some punctuation and symbols

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm

Maximum 1.8 in 45 mm
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Scanner

Scanner has a modern, ‘hi-tech’ look. It is suitable for a wide variety of 
applications.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm

Maximum 1.6 in 40 mm
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Secret Garden-CAPS

Secret Garden-CAPS is a floral alphabet which can be used to decorate many 
items of clothing. Only the capital letters are embellished with flowers, the 
lower case letters are a plain sans serif.

Alphabet contains Letters A - Z (caps only), dash, and brackets

Colors Multi-color

Stitching Satin

Recommended letter height
Minimum 1.5 in 38 mm

Maximum 3.6 in 90 mm



Appendix C : Alphabet Samples

BERNINA® Embroidery Software : Onscreen Manual  498

Speedy

Speedy is a bold, fast-paced modern alphabet.

Alphabet contains Characters A - Z, 0 - 9

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.3 in 8 mm

Maximum 1.2 in 30 mm
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Swiss Block

Swiss Block is based on Helvetica, the great all-purpose sans-serif alphabet. 
It is clean and simple, and suitable for any fabric.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm

Maximum 2.4 in 60 mm
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Tabloid

Tabloid has a Satin outline around the outside edge of the letter shapes. The 
letters have solid, heavy appearance, with a serif-effect. This alphabet 
should be used in larger sizes.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and 
European/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 1.2 in 30 mm

Maximum 3.0 in 75 mm
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Technical Block

Technical Block is a medium weight alphabet with squared serifs which stitch 
cross-ways. It is suitable for lettering in logos at a variety of sizes.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.32 in 8 mm

Maximum 2.0 in 50 mm
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Tiffany

Tiffany is an upright calligraphy script style where the letters do not join. 
The style is bold and extended, and suited for monograms, homewares, etc.

Varsity Appliqué-CAPS

Varsity Appliqué-CAPS is a large alphabet suitable for making appliqué 
letters for college, school and university wear. Each letter includes three 

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.28 in 7 mm

Maximum 1.4 in 35 mm
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stitching layers – first a placement line, then a zigzag tackdown, and finally 
a Satin cover stitch.

Varsity Block-CAPS

Varsity Block-CAPS is a bold serif block alphabet. It is suitable for 
athletic-style lettering on garments, and for general use in logos, etc.

Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Appliqué

Recommended letter height
Minimum 1.2 in 30 mm

Maximum 3.0 in 75 mm
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Alphabet contains Characters A - Z (caps only), 0 - 9, punctuation and symbols, and 
European/special characters

Colors 1 color

Stitching Satin 

Recommended letter height
Minimum 0.25 in 6 mm

Maximum 1.4 in 35 mm
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Verdana

Verdana is a modern sans-serif alphabet that is very popular with web 
designs but lends itself to embroidery as a substitute, for example for Swiss 
Block.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm

Maximum 2.4 in 60 mm
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Victoria

Victoria is an opulent alphabet reminiscent of late 19th century stylings.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.4 in 10 mm

Maximum 2.0 in 50 mm
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Zurich

Zurich is based on one of the most popular calligraphy hand-written styles. 
It is often used in logos and is very popular for personalization.

Alphabet contains Characters A - Z, a - z, 0 - 9, punctuation and symbols, and Euro-
pean/special characters

Colors 1 color

Stitching Satin

Recommended letter height
Minimum 0.25 in 6 mm

Maximum Letters 60 mm
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ПРИЛОЖЕНИЕ D 

 

 
ОБРАЗЦЫ ЗАПОЛНЕНИЯ 

ПРОСТЕГИВАЮЩИМИ СТЕЖКАМИ 
------------------------------------------- 

 
Узоры заполнения простегивающими стежками, показанные в этом приложении, включены в 
вашу программу BERNINA. Указания об оконтуривании и заполнении узорами и об их 
использовании см. в разделе Создание заполнения простегивающим стежком. 
 
Примечание: Будьте уверены в том, что вы правильно выбрали угол орнаментных 
заполняющих стежков. В приводимых ниже образцах при оцифровывании был принят угол 
наклона стежков 0°. Поэкспериментируйте с разными углами наклона для получения новых 
эффектов. 
 
 
 

 



Приложение D: Образцы заполнения простегивающими стежками 

BERNINA® Вышивальное ПО Версия 6 509

 
 

 



Приложение D: Образцы заполнения простегивающими стежками 

BERNINA® Вышивальное ПО Версия 6 510

 
 
 



Приложение E: Образцы заполнения орнаментными стежками 

BERNINA® Вышивальное ПО Версия 6 511

 
ПРИЛОЖЕНИЕ E 

 

 
ОБРАЗЦЫ ЗАПОЛНЕНИЯ 

ОРНАМЕНТНЫМИ СТЕЖКАМИ 
------------------------------------------- 

 
 
Узоры заполнения орнаментными стежками, показанные в этом приложении, включены в вашу 
программу BERNINA. О заполнении орнаментными стежками и указания по их использовании 
см. в разделе Создание заполнения орнаментным стежком. 
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017 Frame (45)

018 Quilt1 (45)

019 Quilt2 (45)

020 Quilt3 (45)

021 Circle (90)

022 Wattle (90)

023 Oval (90)

024 Whirlpool 
(90)

025 Dance (90)

026 Heart (90)

027 Heart2 (90)

ID & Angle Fancy Fill

028 Valentine 
(90)

029 Scallop 
(90)

030 Shell (90)

031 Smile (90)

032 Flower (90)

033 Ribbon (30)

034 Sunny (90)

035 Shine (90)

036 Star (90)

037 Stardust 
(90)

038 
Honeycomb 
(90)

ID & Angle Fancy Fill
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039 Beeswax 
(30)

040 Wave (90)

041 Dunes (0)

042 Chevron 
(90)

043 Chevron2 
(90)

044 Chevron3 
(90)

045 Wedge (90)

046 Crazy (90)

047 Arrow (20)

048 Weave (48)

049 Weave2 
(90)

ID & Angle Fancy Fill

050 Stream (90)

051 Bowtie (0)

052 Chain (90)

053 Glitter (90)

054 Cross (45)

055 
Doublecross 
(90)

056 Galaxy (90)

057 Ring (90)

058 Ramble 
(90)

059 Florastar 
(90)

060 Stripes (90)

ID & Angle Fancy Fill
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061 Letter A 
(90)

062 Letter B 
(45)

063 Letter C 
(90)

064 Letter D 
(45)

065 Letter E 
(45)

066 Letter F 
(45)

067 Letter G 
(45)

068 Letter H 
(45)

069 Letter I (45)

070 Letter J 
(45)

071 Letter K 
(30)

ID & Angle Fancy Fill

072 Letter L 
(45)

073 Letter M 
(45)

074 Letter N 
(45)

075 Letter O 
(30)

076 Letter P 
(45)

077 Letter Q 
(30)

078 Letter R 
(45)

079 Letter S 
(45)

080 Letter T 
(45)

081 Letter U 
(45)

082 Letter V 
(45)

083 Letter W 
(45)

ID & Angle Fancy Fill
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084 Letter X 
(90)

085 Letter Y 
(30)

086 Letter Z 
(30)

087 Paver (90)

088 Picasso 
(135)

089 Ziggy (0)

090 Spirali (90)

091 Manchu 
(45)

092 Grilles (45)

093 Wooden 
Lattice (82)

094 Han Line 
(45)

095 Dart (10)

ID & Angle Fancy Fill

096 T-frame 
(45)

097 
Double-arm 
(87)

098 Knuckled 
frame (45)

099 Tile (0)

100 Alarm Tile 
(83)

101 Turtle-back 
(79)

102 Stepped 
Wave (45)

103 Crayon (0)

104 Diamond 
Inlay (0)

105 Corduroy 
(0)

106 Diamond 
Punch (0)

ID & Angle Fancy Fill
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107 Inlay Print 
(0)

108 Snowflake 
(0)

109 Inlay Maze 
(45)

110 Quilt 
Diamond 1 (0)

111 Quilt 
Diamond 2 (0)

112 Quilt 
Diamond 3 (0)

113 Zig-Zag 
Inlay (0)

114 Shell Inlay 
(0)

115 Music 1 (0)

116 Music 2 (0)

117 Four 
Square (45)

ID & Angle Fancy Fill

118 Symbol 1 
(45)

119 Symbol 2 
(50)

120 Symbol 3 
(82)

121 Wave 2 (0)

122 Wave 3 (0)

123 
Honeycomb 2 
(45)

124 Rope (0)

125 Tree (142)

126 Wings 
(135)

127 Leaf (0)

128 Star (18)

ID & Angle Fancy Fill
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129 Web (0)

130 Tear Drop 
(0)

131 2-way 
zig-zag (87)

132 Quilt 
Square 1 (45)

133 Quilt 
Square 2 (0)

134 Quilt 
Square 3 (0)

135 Quilt 
Square 4 (0)

136 Quilt 
Square 5 (45)

137 Quilt 
Square 6 (18)

138 Cloud Band 
1 (25)

139 Cloud 
Bands 2 (0)

ID & Angle Fancy Fill

140 Cloud 
Bands 3 (0)

141 Arrow 2 (0)

142 Rusty Ice 
(0)

143 Ice Rays 
(0)

144 Dynasty (0)

145 Windwheel 
(0)

146 Tea Tray 
(0)

147 Cash Bars 
(45)

148 Chengtu (0)

149 Chihli (86)

150 Ming (135)

ID & Angle Fancy Fill
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151 Arrowhead 
(89)

152 Basket2 
(40)

153 Bird (90)

154 Blocks2 (0)

155 Chain (90)

157 Circle (0)

158 Cube (48)

159 Ellipse (0)

160 Flame (90)

161 Jem (90)

162 Leaf (0)

163 Melody (0)

ID & Angle Fancy Fill

164 Metal (0)

165 Passage 
(0)

166 Piccolo (0)

167 Roma (0)

168 Rope (10)

169 Seville (0)

170 Star5 (10)

172 Tick (0)

173 Tile1 (135)

174 Tile3 (0)

175 Vine (0)

ID & Angle Fancy Fill
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176 Wave2 (90)

177 Wave3 (90)

178 Whirl (90)

179 Wild (48)

180 Xmastree 
(48)

ID & Angle Fancy Fill



Приложение F: Узорные штампы, оконтуривание и заполнение узорами 

BERNINA® Вышивальное ПО Версия 6 520

 
ПРИЛОЖЕНИЕ F 

 

 
УЗОРНЫЕ ШТАМПЫ, 

ОКОНТУРИВАНИЕ И ЗАПОЛНЕНИЕ 
УЗОРАМИ 

------------------------------------------- 
 
Ниже приведены узорные штампы, оконтуривание и заполнение узорами, которые включены в 
вашу программу BERNINA. .См. также в разделе Узорные штампы, оконтуривание и 
заполнение узорами. 
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NP005-14

NP005-15

NP005-16

NP005-17

NP005-18

NP005-19

NP005-20

NP005-21

NP005-22

NP005-23

Name Pattern

NP005-24

NP005-25

NP005-26

NP005-27

NP005-28

NP005-29

NP005-30

NP005-31

NP005-32

NP005-33

NP005-34

Name Pattern
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Pattern set: Children

NP005-35

NP005-36

NP005-37

NP005-38

NP005-39

NP005-40

NP005-41

NP005-42

NP005-43

Name Pattern

NP005-44

NP005-45

NP005-46

NP005-47

NP005-48

NP005-49

NP005-50

Name Pattern

901

Name Pattern
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Pattern set: Corners

905

907

909

910

911

914

929

Name Pattern

Cnr001

Cnr002

Name Pattern

Cnr003

Cnr004

Cnr005

Cnr006

Cnr007

Cnr008

Cnr009

Name Pattern
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Pattern set: Cross

Cnr010

Cnr011

Cnr012

Cnr013

Cnr014

Cnr015

Cnr016

Cnr017

Name Pattern

Cnr018

Cnr019

Cnr020

Name Pattern

301

302

303

305

309

311

Name Pattern
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Pattern set: Embellishment 

313

b301

b302

b303

b304

b305

b306

b307

 b308

b309

b310

Name Pattern

Name Pattern

601

605

608

610

612

614

618

623

629

637

641

644
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Pattern set: Heirloom

648

653

Name Pattern

705

706

709

710

711

717

718

719

724

Name Pattern

726

728

732

733

738

a701

a702

a703

a704

a705

a706

Name Pattern
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Pattern set: Home Dec

Name Pattern

401

402

403

405

406

407

409

411

412

413

414

415

416

417

422

424

425

426

427

429

430

431

a401

Name Pattern
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Pattern set: Misc

a402

a403

a404

a405

a406

a407

a408

a409

Name Pattern

10

Name Pattern

11

12

13

21

29

Star

3wave

Heart

Wedge

Blanket

Feather

Pinstit

Name Pattern
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Pattern set: Monogram Ornaments

Name Pattern

M001a

M001b M001a pattern oriented horizontally 
and mirrored

M002a

M002b M02a pattern oriented horizontally

M003a

M004a

M004b M004a pattern oriented horizontally

M005a

M005b M005a pattern oriented horizontally 
and mirrored

M006a

M006b M006a pattern oriented horizontally

M007a

M008a

M008b M008a pattern oriented vertically

M009a

M009b M009a pattern oriented horizontally

M010a

M010b M010a pattern oriented horizontally

Name Pattern
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M011a

M011b M011a pattern oriented horizontally

M012a

M012b M012a pattern oriented horizontally

M013a

M013b M013a pattern oriented horizontally

M014a

M014b M014a pattern oriented vertically and 
mirrored

M015a

M015b M015a pattern oriented horizontally

Name Pattern

M016a

M016b M016a pattern oriented horizontally

M017a

M018a

M018b M018a pattern oriented vertically

M019a

M019b M019a pattern oriented horizontally

M020a

M020b M020a pattern oriented horizontally

M021a

Name Pattern
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M021b M021a pattern oriented horizontally

M022a

M022b M022a pattern oriented diagonally

M023a

M023b M023a pattern oriented horizontally

M024a

M024b M024a pattern oriented diagonally

M024c M024a pattern oriented horizontally

M025a

M025b M025a pattern oriented horizontally

Name Pattern

M026a

M026b M026a pattern oriented horizontally

M027a

M027b M027a pattern oriented vertically

M028a

M028b M028a pattern oriented diagonally

M029a

M029b M029a pattern oriented horizontally

M030a

M030b M030a pattern oriented horizontally

Name Pattern
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M031a

M031b M031a pattern oriented horizontally

M032a

M032b M032a pattern oriented horizontally

M033a

M033b M033a pattern oriented horizontally

M034a

M034b M034a pattern oriented vertically

M035a

M035b M035a pattern oriented horizontally

Name Pattern

M036a

M036b M036a pattern oriented horizontally

M037a

M037b M037a pattern oriented horizontally

M038a

M038b M038a pattern oriented horizontally

M039a

M039b M039a pattern oriented horizontally

M040a

M040b M040a pattern oriented horizontally

Name Pattern
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M041a

M041b M041a pattern oriented horizontally

M042a

M042b M042a pattern oriented vertically

M042c M042a pattern oriented diagonally

M043a

M043b

M043c M043a pattern oriented horizontally

M044a

M044b M044a pattern oriented vertically

M045a

M045b M045a pattern oriented horizontally

Name Pattern

M046a

M046b M046a pattern oriented horizontally

M047a

M047b M047a pattern oriented horizontally

M048a

M048b M048a pattern oriented horizontally

M049a

M049b M049a pattern oriented horizontally

M050a

M050b M050a pattern oriented horizontally

Name Pattern
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M051a

M051b M051a pattern oriented diagonally

M052a

M053a

M054a

M055a

M055b M055a pattern oriented vertically

M056a

M057a

M057b M057a pattern oriented diagonally 
and mirrored

M058a

M059a

Name Pattern

M059b M059a pattern oriented horizontally

M060a

M061a

M061b M061a pattern oriented horizontally

M062a

M062b M062a pattern oriented horizontally

M063a

M064a

M064b M064a pattern oriented horizontally

M065a

M066a

M066b M066a pattern oriented horizontally

M067a

Name Pattern
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M067b M067a pattern oriented vertically

M068a

M069a

M069b M069a pattern oriented vertically

M070a

M071a

M071b M071a pattern oriented vertically

M072a

M072b M072a pattern oriented horizontally

M072c M072a pattern oriented diagonally

M073a

M073b M073a pattern oriented vertically

M073c M073a pattern bigger sized

Name Pattern

M073d

M073e M073d pattern oriented vertically

M073f

M073g M073f pattern oriented horizontally

M073h

M073i M073h pattern oriented horizontally

M073j

M073k M073j pattern oriented diagonally

M073l M073j pattern oriented vertically

M074a

M074b
M074a pattern oriented 

horizontally

M074a
M074a pattern oriented 

vertically

M074g

M075a

Name Pattern
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M075b

M075c M075b pattern mirrored

M075d M075b pattern oriented vertically

M076a

M076b M076a pattern oriented vertically

M077a

M077b M077a pattern oriented vertically

M078a

M078b M078a pattern smaller sized

M078c M078b pattern oriented vertically

M079a

M079b M079a pattern smaller sized

M079c M079b pattern oriented vertically

M080a

M080b M080a pattern smaller sized

M080c M080b pattern oriented vertically

M081a

M081b M081a pattern smaller sized

Name Pattern

M081c M081b pattern oriented vertically

M082a

M082b M082a pattern oriented vertically

M083a

M083b M083a pattern oriented vertically

M084a

M084b M084a pattern oriented vertically

M085a

M085b M085a pattern smaller sized

M085c M085b pattern oriented vertically

M086a

M086b M086a pattern oriented vertically

M087a

M087b M087a pattern smaller sized

M087c M087b pattern oriented vertically

Name Pattern
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M088a

M088b M088a pattern oriented horizontally

M088c M088a pattern oriented diagonally

M089a

M089b M088a pattern oriented vertically

M089c

M090a

M090b M090a pattern oriented horizontally

M090c M090a pattern oriented diagonally

M090d

M090e M090d pattern oriented vertically

M091a

M091b M091a pattern oriented vertically

M091c M091a pattern oriented diagonally

M092a

Name Pattern

M092b M092a pattern oriented vertically

M092c

M092d M092e pattern mirrored vertically and 
horizontally

M092e M092e pattern mirrored horizontally

M093a

M093b M093a pattern oriented vertically

M093c

M093d M093c pattern oriented diagonally

M093e M093c pattern oriented vertically

M093f

M094a

M094b M094a pattern oriented vertically

M094c M094a pattern oriented diagonally

M095a

M095b

M096a

Name Pattern
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Pattern set: NP004a

M096b M096a pattern oriented vertically

M096c

M096d

M097a

M097b M097a pattern oriented vertically

M097c

M097d M097c pattern oriented horizontally

M097e M097c pattern oriented diagonally

M098a

M098b M098a pattern oriented vertically

M098c

M098d M098c pattern oriented vertically

M099a

M099b M099a pattern oriented right

M099c M099a pattern oriented downwards

M099d M099a pattern oriented left

M099e M099a pattern oriented diagonally

Name Pattern

M0100a

M0100b M0100a pattern bigger sized

Name Pattern

K0001a

K0002a

K0003a

K0004a

K0005a

K0006a

K0007a

K0008a

Name Pattern
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K0009a

K0010a

K0011a

K0012a

K0013a

K0014a

K0015a

K0016a

K0017a

K0018a

K0019a

K0020a

K0021a

K0022a

Name Pattern

K0023a

K0024a

K0025a

K0026a

K0027a

A200026

A200150

A200446

A200602

A200606

A200609

A200615

A200749

Name Pattern
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Pattern set: NP005a

Pattern set: Nature

Name Pattern

151a

151b

152a

437a

660a

663a

701a

1023a

1024a

1026a

1027a

Name Pattern

101

102

103

106

111

112

113

114

115

Name Pattern
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Pattern set: Quilting

117

118

119

124

129

135

136

Name Pattern

327

328

330

332

Name Pattern

333

334

336

337

338

339

340

342

343

a301

a302

a303

a304

Name Pattern
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Pattern set: Satin-Quilt

a305

a306

a307

a308

a309

a310

a311

a312

a313

a314

a315

a316

Name Pattern

Name Pattern

501

503

506

507

508

509

511

512

513



Appendix F : Pattern Stamp, Run and Fill Samples

BERNINA® Embroidery Software : Onscreen Manual  543

Pattern set: Carving Stamps

514

515

Name Pattern

0

 

1

2

3

4

5

Name Pattern

6

7

8

9

A

B

C

D

Name Pattern
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E

F

G

H

I

J

K

L

Name Pattern

M

N

O

P

Q

R

S

T

Name Pattern
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U

V

W

X

Y

Z

Cylinder

Triangle

Name Pattern

Ring_Half

Trapezoid

Arrow_3_Way

Arrow_4_Way

Arrow_Block

Ring_Ellipse

Parallelogram

Page

Name Pattern
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Tear

Arrow_4_Way_
Block

Arrow_Right_
Angle

Arrow_Double
_Block

Arrow

Cross

Flash

Flame

Name Pattern

Heart

Banned

Smiley

Arrow_Double
_Right_Angle

Polygon

Name Pattern
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ПРИЛОЖЕНИЕ G 

 

 
ОБРАЗЦЫ УЗОРОВ РУКОДЕЛЬНЫХ 

СТЕЖКОВ 
------------------------------------------- 

 
Образцы узоры рукодельных стежка, показанные в этом приложении, включены в вашу 
программу BERNINA. О применении рукодельных стежков (Craft Stitches) см. раздел 
Оконтуривание и заполнение рукодельными стежками. 
 
Узоры заполнения "Блэкуорк" 
Техника Blackwork (дословно "черная работа") 
получила свое название от черных шелковых 
ниток, используемых в этом виде вышивания. 
Узоры Blackwork можно использовать как для 
оконтуривания, так и для заполнения. В 
большинстве случаев при таком "черно-белом" 
заполнении используются простые стежки для 
создания комплексных геометрических узоров. 
См. разделы Создание контуров обрамления в 
технике "черной вышивки" ("блэкуорк") и 
Создание заполнений в технике "черной 
вышивки" ("блэкуорк"). 
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Узоры Candlewicking  
 
Вышивание узелковыми строчками 
(Candlewicking) является традиционной техникой 
вышивания "белым-по-белому", выполняемому 
обычно на белой льняной или 
хлопчатобумажной ткани толстыми 
хлопчатобумажными нитками. Узоры 
Candlewicking можно использовать как для 
оконтуривания, так и для заполнения. См. 
разделы Создание контуров обрамления 
стебельчатыми стежками и Создание 
заполнений строчками в технике candlewicking. 
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Узоры кружевного 
переплетения 
 
Стежки кружевного переплетения образуют 
похожие на сетку узоры, которые придают 
объекту вид кружева.  Этот метод можно 
применять для объектов в виде замкнутых 
кривых или прямоугольников, заполняемых 
стежками с единым углом наклона. Подробнее 
см. в разделе Создание заполнения стежками 
кружевного переплетения. 
 
 




